
 

 

 

Leddar™ Vu8 
8 Segment Solid-State 
LiDAR Sensor Module 

USER GUIDE 

TF ID 013728 



 

2 | 110 © 2021 LeddarTech Inc. 

 

This page intentionally left blank 
  



 

54A0028_V8.0_EN / Leddar Vu8 – User Guide 3 | 110 

 

© 2021 LeddarTech Inc. All rights reserved. 

The information contained herein is the property of the Company and shall not be reproduced in whole or in 
part without the prior written approval of the Company. 
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Inc. and its subsidiaries. All other brands, product names and marks are or may be trademarks or registered 
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contained in this document or regarding LeddarTech products. For the most recent version of this document, 
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Conditions, Product Warranty and End-User License Agreement carefully. Documentation available at 
www.leddartech.com, section “Resources.” 
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DISCLAIMER 

LeddarTech® shall not be liable for any errors or omissions herein or for any damages arising out of or related 
to this document or the information contained herein, even if LeddarTech has been advised of the possibility 
of such damages. 

Descriptions of products, including, but not limited to, specifications and drawings, and other related 
information contained in this document, are provided only to illustrate their operation and application 
examples. The illustrations shown, including screen captures, may differ from the appearance of the actual 
product. 

LeddarTech has made every effort to ensure that the information contained in the documentation 
accompanying its products, including, without limitation, its Specification Sheet, is accurate. However, 
LeddarTech will not be liable for any errors or omissions therein and reserves the right to modify the design 
and characteristics of products at any time without notice. For the most recent version of any product 
documentation, visit LeddarTech’s website at www.leddartech.com. In case of discrepancy, the web version 
takes precedence over any printed literature. 

LeddarTech may expressly designate certain products as completing a particular qualification (e.g., AEC-
Q100). Customer agrees that it has the necessary expertise to select the product with the appropriate 
qualification designation for its applications and that proper product selection is at customer’s own risk. The 
customer is solely responsible for compliance with all legal and regulatory requirements in connection with 
such selection. 

LeddarTech does not control the installation and use of its products and shall have no liability if a product is 
used for an application for which it is not suited. LeddarTech’s products are not recommended or authorized 
for safety, life support, medical applications, applications involving hazardous, corrosive or radioactive 
substances or for any use or application in which the failure of a component could cause personal injury, 
loss of life or substantial harm to the environment or property. Where LeddarTech specifically promotes 
products as facilitating functional safety or as compliant with functional safety standards, such products are 
intended to help enable customers to design and create their own applications that meet applicable functional 
safety standards and requirements. Using products in an application does not by itself establish any safety 
features in the application. 

Any technical advice provided by LeddarTech with reference to the use of its products is given without 
assumption by LeddarTech of any liability, and LeddarTech assumes no obligation or liability for the advice 
given or results obtained, all such advice being given and accepted at customer’s sole risk. 

LeddarTech reserves the right to modify its products at any time, without notice, at its sole discretion. The 
products’ performance specifications and operating parameters are determined in an independent state and 
are not guaranteed to perform the same way if installed in a customer product. 
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Arial bold 
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Note: Contains helpful suggestions and references to information included within 
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1. Introduction 

The Leddar Vu8 module enables developers and integrators to make the most of Leddar™ technology 
through integration in detection and ranging systems. The purpose of the Leddar Vu8 module is to be easily 
and rapidly integrated into various applications. 

The Leddar Vu8 can be configured for elementary applications or perform more complex tasks depending 
on the hardware and software settings. 

1.1. Description 

The Leddar Vu8 module contains the following: 

• Source and control assembly 

• Receiver assembly 

The module comes in two configurations: 

1. SPI 

2. USB, CAN and serial 

Depending on the configuration, they offer the following features: 

• Horizontal field of view (HFoV): 16°, 48° and 99° 

• Vertical field of view (VFoV): 0.3°, 2° and 3° 

• Eight detection segments 

• Real-time data acquisition and display (through SPI) 

• SPI (serial peripheral interface) for the direct link with the receiver (SPI carrier board) 

• I2C interface to read the optional temperature sensor on the source module (SPI carrier board) 

• Serial link interface: TTL, RS-232, RS-422 and RS-485 (USB, CAN and serial carrier board) 

• USB interface (USB, CAN and serial carrier board) 

• CAN bus interface for acquisition (USB, CAN and serial carrier board) 

 

Fig. 1: Leddar Vu8 general elements 

Receiver 

Emitter 

Two-pin power 
connector 
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Receiver assembly 

The receiver assembly contains the photodetector array (eight elements), the circuit receiver and a processor 
(MCU). 

The module generates a full waveform per segment at its measurement rate. 

 

Lens coating color for 48° configuration may change from one sample to another from 
greenish to bluish, but the inherent properties of the lens are not affected in the field of 
application of this product. 

Emitter assembly 

The emitter assembly includes the emitter, the emitter driver circuit and the temperature sensor. 

Light source pulsing is controlled by the receiver assembly since the receiver data acquisition must be 
synchronized with the light source pulses. The temperature sensor, located near the light source, is used to 
implement temperature compensation on the ranging results. 

Power connection 

The power connection is a two-pin connector that provides the module with a 12 V power source. 

1.2. SPI Carrier Board 

 

Fig. 2: Leddar Vu8 SPI carrier board 

 
Power outputs can supply up to 15 mA. 

Pin 1: GND 

Pin 4: I2C SDA (input/output) 

Pin 2: I2C SCL (input) 

Pin 10: receiver ready (output) 
Pin 8: receiver sampling (output) 
Pin 6: receiver synchronization (input) 
Pin 4: receiver reset (input) 
Pin 2: GND 

Pin 2: input power (+12V) 

Pin 3: receiver ready (output) 

Pin 1: GND 

Pin 9: SPI CS (input) 
Pin 7: SPI MOSI (input) 

Pin 5: SPI MISO (output) 
Pin 3: SPI CLK (input) 

Pin 1: GND 



 

54A0028_V8.0_EN / Leddar Vu8 – User Guide 19 | 110 

1.3. USB, CAN and Serial Carrier Board 

 

Fig. 3: Leddar Vu8 USB, CAN and serial carrier board 

 
Power outputs can supply up to 15 mA. 

DIP switches 

The DIP switches are used for the configuration of serial port number 1. This port is configurable to these 
EIA electrical interfaces for the following standard serial communication ports: 

• RS-232 

• RS-485 two-wire configuration 

• RS-422/RS-485 four-wire configuration 

Table 1: Communication port configuration (six-position DIP switch) 

Interface 
DIP Switch Position 

1 2 3 4 5 6 

RS-232 OFF OFF ON OFF OFF X 

RS-485 two-wire 
configuration 

ON ON OFF ON ON X 

RS-422/RS-485 
four-wire config-
uration 

ON OFF ON OFF OFF X 
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On all port configurations, the module is still a half-duplex slave. 

Table 2: Communication port configuration (eight-position DIP switch) 

Interface 
DIP Switch Position 

1 2 3 4 5 6 7 8 

RS-232 OFF ON OFF OFF OFF X X X 

RS-485 two-wire con-
figuration 

ON OFF ON ON ON X X X 

RS-422/RS-485 four-
wire configuration 

ON ON OFF OFF OFF X X X 

 

 

DIP switch position 6 on ON position enables a 121 Ω termination resistor to RS-485 two-
wire configuration only (must be kept on OFF position in any other configuration). 

DIP switch position 8 on ON position enables a 121 Ω termination resistor to CAN port. 

Configurable serial link 1 

Depending on the DIP switch positions, the configurable serial link pin functionalities differ (see Table 3). 

Table 3: Communication link configuration 

 Interface 

Pin Position RS-232 
RS-485 two-wire 

configuration 
RS-422/RS-485 four-wire 

configuration 

1 GND GND GND 

3 RTS D- Dout- 

5 NC NC NC 

7 Rx D- Din+ 

9 Tx D+ Dout+ 

11 CTS D- Din- 

 

 

If a two- or four-wire differential port configuration is selected, depending on the network 
configuration, you should put bias resistors on transmitter or receiver lines to maintain the 
proper idle voltage and force the line to the idle condition. 

Push buttons 

The S1 push button is used for hard reset purposes; a short press resets the module. 

The S3 push button is used for special purposes (see Table 4). 
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Table 4: S3 push button functionalities 

Description Action 

Long press during 
module operation 
(longer than 
10 seconds) 

Resets the carrier board configuration to the default values: 

CAN port configuration 

• 1 Mbps, standard frame format 

• Base Rx: 0x740 

• Base Tx: 0x750 

• No delay 

• Distance in cm and a max. of 96 echoes 

Serial link configuration 

• 115 200 bps, 8 bits, no parity, no flow control, 1 stop bit 

• Distance in cm and a max. of 40 echoes 

• Modbus address: 1 

S3 button pressed 
for more than 
2 seconds during 
startup (or after a 
hard reset) 

Set the USB, CAN and serial carrier board to bootloader mode. This feature is 
used to upgrade the USB, CAN and serial carrier board firmware. 

Use the LeddarTech software tool to upgrade the firmware. 
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1.4. Working Diagram 

 

Fig. 4: Leddar Vu8 working diagram 
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1.4.1. SPI Carrier Board 

SPI and control interface 

The SPI serial port functionalities are available via pins 3, 5, 7 and 9. The port has a standard signal level of 
0 V to 3.3 V. 

Table 5: SPI pin definition 

Pin Function 

3 CLK (input) 

4 Hard reset (input) 

5 MISO (output) 

7 MOSI (input) 

9 CS (input) 

I2C interface 

The Integrated Circuit (I2C) protocol is intended to allow multiple slave digital circuits to communicate with 
one or more master circuits. As for the SPI, it is only intended for short-distance communications. The port 
has a standard signal level of 0 V to 3.3 V. 

Power supply 

The power source includes the source, the auxiliary DC output connection, the +12 V connection, the +5 V 
analog supply and the +3.3 V supply. 

1.4.2. USB, CAN and Serial Carrier Board 

The optional carrier board includes the following: 

Serial ports (TTL, RS-232, RS-422 and RS-485) 

The TTL port is used for the short-range transmission of data. The port has a standard signal level of 0 V to 
3.3 V. 

The RS-232 is used for the transmission of data. It defines the signals connection between the data terminal 
equipment (such as a computer) and the data circuit-terminating equipment (such as a modem). 

The RS-422 (ANSI/TIA/EIA-422-B), a four-wire configuration, specifies the electrical characteristics of the 
digital signaling circuit. It can transmit data at rates as high as 10 Mbits/s or may be sent on cables as long 
as 1500 meters. Some systems directly interconnect and may be used to extend the range of an RS-232 
connection. 

The RS-485 (ANSI/TIA/IEA-485) is a two- or four-wire differential serial communication port. It is often used 
in electrically noisy environments. 

Microcontroller MCU 

The source and control assembly is equipped with an MCU on the carrier board. It is provided to transmit 
data from the receiver module through the communication ports. 

USB interface 

The USB interface is a compatible 2.0, full-speed 12-Mbit/s port. This interface emulates a VCP (virtual COM 
port) used as a serial port. 
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Application and Reset switch 

The Reset switch restarts the module. This can be used as an alternative to cycling the power. 

Serial link configuration DIP switches 

The source and control assembly is equipped with ten DIP switches. Five are used to configure serial link 1 
(see Fig. 2 and Fig. 3). 

CAN bus interface 

The CAN bus is implemented via a differential pair. The ISO 11898 standard describes the CAN technology. 
The interface has a level of 3.3 V. 

2. Underlying Principles 

Created by LeddarTech, Leddar™ (light-emitting diode detection and ranging) is a unique sensing 
technology based on the laser illumination (infrared spectrum) and the time-of-flight of light principle. The 
light source illuminates the area of interest (pulsed typically at 10 kHz for the 48° Leddar Vu8 module) and 
the multichannel module receiver collects the backscattered light and measures the time taken for the light 
to return to the module. 

An eight-channel photodetector array is used and provides multiple detections and ranging segments. Full-
waveform analysis enables the detection and distance measurement of multiple objects in each segment, 
provided that foreground objects do not fully obscure objects behind them. Oversampling and accumulation 
techniques are used to provide extended resolution and range. 

Fig. 5 illustrates the illumination area and detection segments. In this case, the eight segments provide a 
profile of the object in the beam. In other installations, the channels can be used to locate and track one or 
multiple objects in the beam. 

 

Fig. 5: Illumination area and detection zone 

The core of Leddar™ sensing is the pulsing of diffused light, collection of reflected light (including 
oversampling and accumulation) and full-waveform analysis. The light source type, the number of light 
sources, the illumination and reception beam and the number of photodetectors can all be tailored to fit 
specific application requirements such as detection range, beam and spatial resolution. 
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3. Getting Started 

3.1. Power Supply (Optional) 

The power supply included with the Starter Kit version of the Leddar Vu8 has a pluggable terminal block that 
connects to the 12 V header connector of the Leddar Vu8 module. See Fig. 2 or Fig. 3 for the location of the 
12 V header pin. 

 

Fig. 6: Optional power supply terminal block 

3.2. SPI Cable (Optional) 

Table 6 below shows the pinout of the optional SPI cable sold by LeddarTech. See Fig. 2 for connection 
information. 

Table 6: Optional SPI cable pinout 

Wire Color Function 

Black Ground 

Blue Reset_N 

Orange SCLK 

Green MISO 

Yellow MOSI 

Brown CS# 

3.3. Setup 

This section presents the Leddar™ Configurator installation and the procedure to set up the Leddar Vu8 
module. All software operations are described in section “6. Leddar Configurator” on page 71. 

To install Leddar™ Configurator: 

1. Download the LeddarInstaller.exe file from our web site at www.leddartech.com/resources/#product-
download/. 

a. If you are a new user, fill the form and click Submit. 

b. If you are a registered user, log in by entering your email address and password, then click Log In. 

2. In the Software Download section, select a product, then click LeddarInstaller.exe. Double-click the 
file to start the installation. 

3. On your computer desktop, double-click the  Leddar Configurator icon. 

GND 12 V 

http://www.leddartech.com/resources/#product-download/
http://www.leddartech.com/resources/#product-download/
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4. In the Welcome to the Leddar™ Software Setup Wizard dialog box, click Next. 

 

Fig. 7: Welcome dialog box 

5. In the End-User License Agreement dialog box, read the terms of the agreement, select the I accept 
the terms in the License Agreement check box, then click Next. 

 

Fig. 8: End-User License Agreement dialog box 
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6. In the Product Types dialog box, the Leddar™ Configurator check box is selected by default. 

 

Fig. 9: Product Types dialog box 

7. Click Next. 

8. In the Destination Folder dialog box, click Next to select the default destination folder. 

OR 

Click the Change… button to choose a destination folder. 

 

Fig. 10: Destination Folder dialog box 

9. In the Ready to Install Leddar™ Software dialog box, click the Install button. 

 

Fig. 11: Installation dialog box 
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10. In the Leddar™ Setup Wizard Completed dialog box, click Finish. 

 

Fig. 12: Completing the installation 

Leddar Configurator creates an icon on the computer desktop. 

3.4. Connecting to the Module 

The first time the module is connected to a computer, a few seconds are required for Windows™ to detect it 
and complete the installation. 

Once the installation is completed, you can connect to the module. 

To connect to the module: 

1. Connect the power cord to the module and to a power outlet. 

2. Connect the USB cable to the module and to the computer. 

3. On the computer desktop, double-click the Leddar™ Configurator icon. 

4. In Leddar Configurator, click the  Connect icon. 

 

Fig. 13: Connecting to a module 
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5. In the Select a connection type list of the Connection dialog box, select either Leddar Vu8 SPI for a 
standard board or Leddar Vu8 USB/Serial for a USB, CAN and serial. 

 

Fig. 14: Connection dialog box 

6. Select the appropriate device and click the Connect button. 

The main window displays the detections (green lines) in the segments (white lines). 

 

Fig. 15: Main window 

A complete description of Leddar Configurator features and parameters for the Leddar Vu8 module can be 
found in section “6. Leddar Configurator.” 
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4. Measurements and Settings 

4.1. Distance Measurement 

Distance is measured from the base of the standoffs for the Leddar Vu8 module. 

 

Fig. 16: Distance measurement 

The dashed lines illustrate one of the eight segments and the solid line indicates the distance measured by 
the sensor in that segment. 

4.2. Data Description 

Data displayed in the Raw Detections dialog box allow you to precisely define the desired detection 
parameters (View menu > Raw Detections). 

 

Fig. 17: Raw Detections dialog box 

An object crossing the beam of the sensor is detected and measured. It is qualified by its distance, segment 
position and amplitude. The quantity of light reflected to the module by the object generates the amplitude. 
The bigger the reflection, the higher the amplitude will be. 

The amplitude is expressed in counts. A count is the unit value of the used ADC in the receiver. The fractional 
of counts is caused by the accumulation to achieve more precision. 
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Table 7: Raw Detections field description 

Field Description 

Segment (Seg) Beam segment in which the object is detected 

Distance Position of the detected object 

Amplitude Quantity of light reflected by the object and measured by the sensor 

Flags 8-bit status (bit field). See Table 8. 

The Flags field provides the status information that indicates the measurement type. 

Table 8: Flag value description 

Bit position Bit = 0 Bit = 1 

0 Invalid measurement Valid measurement 

1 Normal measurement Measurement is the result of demerging processing. 

2 Reserved Reserved 

3 Normal measurement 

Received signal is above the saturation level. 

Measurements are valid (VALID is set) but have lower accuracy 
and precision. 

Consider decreasing the light source Intensity value. 

4 Reserved Reserved 

5 Reserved Reserved 

6 Reserved Reserved 

7 Reserved Reserved 

The Flags field provisions for eight bits encoded as a bit field. Three bits are currently used. The following 
table lists the implemented decimal values of the status bit field. 

Table 9: Status value description 

Status Value (Decimal) Status Value (Binary) Description 

1 00000001 Normal measurement (valid) 

9 00001001 Saturated signal (valid) 
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4.3. Acquisition Settings 

Acquisition settings allow you to define parameters to use for detection. 

To open the Acquisition Settings dialog box, select Device, then Configuration, then click Acquisition. 

4.3.1. General Settings 

 

Fig. 18: Acquisition Settings dialog box – General tab 

To apply new acquisition settings, click the  Apply icon in the main window. 
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Table 10: Acquisition settings description 

Parameter Description Range 

Accumulation 

Number of accumulations 

Higher values enhance range and reduce measurement rate and 
noise. When you increase the accumulation value, you reduce the 
noise as well as the measurement rate. Depending on the 
application, a reduction of the noise might be more important than a 
high measurement rate. 

1 

2 

4 

8 

16 

32 

64 

128 

256 

512 

1024 

Oversampling1 

Number of oversampling cycles 

Higher values enhance resolution (accuracy) and reduce the 
measurement rate. When you increase the oversampling value, you 
increase the resolution (accuracy) but reduce the measurement rate. 
Depending on the application, a higher resolution might be more 
important than a high measurement rate. 

1 

2 

4 

8 

16 

32 

Points 

Number of base sample points 

Determines the maximum detection range. The more points there 
are, the more they have an impact on the processing load since it 
impacts the number of sample points to process for each segment. 

2 to 128 

Threshold Offset 

Modification to the amplitude threshold 

Higher values decrease the sensitivity and reduce the range. 

See below for more details. 

−50.00 to 
500.00 

Smoothing 

Object smoothing algorithm. Smooths the sensor measurements. 

The behavior of the smoothing algorithm can be adjusted by a value 
ranging from −16 to 16. Higher values enhance the sensor precision 
but reduce its reactivity. 

The smoothing algorithm can be deactivated by clearing the Enable 
check box. 

The measurement smoothing algorithm is advised for applications 
that need to measure slowly moving objects with high precision. 

For applications requiring to quickly track moving objects, the 
smoothing should be configured with a value lower than 0 or simply 
deactivated. 

See below for more details. 

−16 to 16 

 

1 Oversampling of 1 and 2 might lead to accuracy below specification. 
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Parameter Description Range 

Light Source 
Control 

Light source power control options 

Allow you to select between Manual and Automatic modes. In 
Automatic mode, the light source power is adjusted according to 
incoming detection amplitudes. 

The current light source power level is visible in the View > State > 
Device State window. 

See below for more details. 

100% 

81% 

53% 

28% 

6% 

Change Delay 
(Channel and 
Frame) 

Minimum frame delay between power changes 

Smaller values speed up the response time of the light source power 
adjustment. 

Channel: 0 
to 8 

Frame: 
varies 

Saturation Com-
pensation 

When selected, this parameter allows you to activate the advanced 
distance computation algorithm for very strong (saturated) signals. 
This computation uses slightly more computing power to enhance the 
quality of the distance measurements of saturated light pulses. 

The algorithm classifies the detected pulses based on their shape. 
The sensor determines which pulses are saturated and which have a 
normal shape. Saturated pulse occurs when the signal backscattered 
by the object is so strong that the full-waveform signal is clipped. If 
not treated, this phenomenon creates an important degradation of 
the distance measurement accuracy. 

Enabled 

Disabled 

Static Noise 
Removal 

When selected, this parameter allows you to enhance measurements 
by subtracting the constant electronic noise present at the beginning 
of signals. 

Enabled 

Disabled 

Overshoot Man-
agement 

When selected, this parameter allows you to improve the detection of 
false measurements caused by specific signal shapes. For example, 
this may occur when strongly reflecting objects are present in the 
field of view. 

Enabled 

Disabled 

Crosstalk Re-
moval 

Inter-channel interference noise mitigation 

Crosstalk is a phenomenon inherent to all multiple-segment time-of-
flight sensors. It causes a degradation of the distance measurement 
accuracy of an object when one or more objects with significantly 
higher reflectivity are detected in other segments at a similar distance. 

This option enables an algorithm to compensate for the degradation 
due to crosstalk. 

This algorithm increases the computational load of the sensor 
microcontroller. It is recommended to disable the Crosstalk 
Removal option if the module is configured to run at a rate higher 
than 50 Hz. 

Enabled 

Disabled 

Crosstalk Echo 
Removal 

When selected, this parameter can further increase accuracy by 
removing secondary echoes that might still be present in adjacent 
segments after applying the first stage of crosstalk removal. 

Enabled 

Disabled 
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Parameter Description Range 

Object Demerging 

Near-object discrimination 

Allows you to ease the discrimination of multiple objects in the same 
segment. 

Object demerging is only available for measurement rates under 
5.0 Hz. Also, the accumulation value must be 64 and the over-
sampling value 8. The number of merged pulses that can be pro-
cessed for each frame is also limited. A status field is available in the 
Device State window, indicating if the sensor processes all merged 
pulses. 

The measurement of demerged objects tends to be of lower quality 
than on usual detections. 

Enabled 

Disabled 

Threshold Offset 

The Threshold Offset value allows you to modify the detection amplitude threshold. 

A default detection threshold table was determined to provide robust detection and minimize false detections 
caused by noise in the input signal. 

Fig. 19 presents the threshold table for a light source Intensity value of 16. This table is effective when the 
Threshold Offset value is 0. 

 

Fig. 19: Detection threshold examples 

The multiple lines in each graph present the thresholds for a few accumulations of 1 (top curve), 2, 4, 8, 16, 
32, 64, 128 and 256 (bottom curve). Accumulations of 512 and 1024 are also available, although not shown 
(provide the lowest thresholds). 
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The Threshold Offset parameter has the effect of offsetting each value in the threshold table by the selected 
value. This provides a means of reducing (positive value) or increasing (negative value) the sensor ’s 
sensitivity. Increasing the Threshold Offset value allows ignoring (will not result in a measurement) signals 
with amplitude higher than the default threshold. Decreasing the Threshold Offset value allows 
measurements of amplitude signals lower than the default threshold. 

 

The default setting (0) is selected to ensure a very low occurrence of false measurements. 

False measurements are likely to occur when reducing the Threshold Offset (negative values). These false 
measurements are very random in occurrence, while true measurements are repeatable. For this reason, it 
may be useful in some applications to use a higher sensitivity and filter out the false measurements at the 
application level. For example, this can be useful in applications that require long detection ranges or 
detection of small or low-reflectivity targets. 

Smoothing 

The smoothing algorithm increases the precision of the measurement at the cost of the sensor reactivity. 
The algorithm works by averaging consecutive measurements over a given time history. The history length 
of the filter is defined as a function of the measurement noise level. It also changes according to the 
oversampling and accumulation settings. The history length of the averaging filter can also be adjusted by a 
parameter ranging from −16 to 16. Clear the Enable check box to disable smoothing. Higher values increase 
the sensor precision but reduce its reactivity. An example of the behavior of the measurement smoothing 
algorithm is shown in Fig. 20 below. 

 

Fig. 20: Measurement smoothing example 

The red line represents the true target distance, the blue curve corresponds to the target distance measured 
by the sensor without smoothing and the green curve denotes the smoothed measurements. Noteworthy is 
that the smoothing algorithm dramatically improves the measurement precision (standard deviation). 

 

The smoothing algorithm is recommended for applications that require highly precise 
measurements of slowly moving objects. For applications that track quickly moving 
objects, it is advised to decrease the Smoothing parameter’s value or disable the 
smoothing algorithm. Clear the Enable check box to disable smoothing. 
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Light Source Control 

There are a total of five supported light source power levels. Their approximate relative power is evenly 
distributed between 0 and 100%. 

There are three power control modes: 

• Manual 

• Automatic mode 1 

• Automatic mode 2 

With the Manual mode, the light power source of the sensor is set to a fixed value. This mode can be used 
in a controlled environment of sensor FoV. 

For Automatic mode, the Change Delay parameter allows you to define the number of measurements 
required before allowing the sensor to increase or decrease the light source power level by one. For example, 
with the same Change Delay, the maximum rate of changes (per second) of the light source power will be 
twice higher at 12.5 Hz than at 6.25 Hz. The Change Delay can be set by the number of detection frames 
and the number of saturated segments that can be tolerated (Automatic mode 1 only). 

 

Since the Change Delay parameter is a number of measurements, the delay will vary if 
the measurement rate is changed (through modification of the accumulation and over-
sampling parameters). 

Keeping the sensor in Automatic power mode (default setting) ensures it adapts to varying environments. 
Close-range objects may reflect so much light that they will saturate the sensor, reducing the quality of the 
measurements. This mode will adapt the light output within the Change Delay setting (Channel and Frame 
parameters) to reach the optimal amplitude. On the other hand, low amplitudes provide lower accuracy and 
precision. The Automatic power mode will select a laser intensity that provides the highest intensity to avoid 
the saturation condition. 

Automatic mode 2 will adapt the light output within the Change Delay (Frame parameter only) to reach at 
least one or more segments in saturation condition to provide the highest detection range. This mode is 
useful to keep the highest detection range into non-saturated segments when a strongly reflective object is 
detected. 

 

When a strongly reflective or nearby object is present in the field of view while monitoring 
farther distances, the automatic adjustment will reduce the effective range of the sensor 
(reduced light source Intensity value) and may prevent detection of long-range or low-
reflectivity objects. For these applications, Automatic mode 2 may be a better setting. 

4.3.2. Enabling and Disabling Segments 

To open the Acquisition Settings dialog box, select Device, then Configuration, then click Acquisition. 

Segments are enabled by default. Deactivating a segment can target what needs to be identified in a field of 
view. This has an impact on the measurement rate, which will be faster. 
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Fig. 21: Acquisition Settings dialog box – Segments tab 

The corresponding segments will appear with gray square lines in the main window when you deselect 
segments, as shown below. 

 

Fig. 22: Disabled segments example 

To apply new acquisition settings, click the  Apply icon in the main window. 
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4.4. Measurement Rate 

The Leddar Vu8 sensor acquires a base input waveform for each segment at a rate between 10 kHz and 
40 kHz, depending on the sensor field of view (see Table 11). 

Table 11: Base acquisition rate based on the field of view 

Leddar Vu8 FoV Base Acquisition Rate 

16° 10 kHz 

48° 20 kHz 

99° 40 kHz 

Multiple acquisitions are used to perform accumulations and oversamplings and generate a final waveform 
that is then processed to detect the presence of objects and measure their position. 

The theoretical measurement rate is, therefore: 

𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑚𝑒𝑛𝑡 𝑟𝑎𝑡𝑒 =  
𝐵𝑎𝑠𝑒 𝑟𝑎𝑡𝑒

(𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑠𝑒𝑔𝑚𝑒𝑛𝑡𝑠 𝑒𝑛𝑎𝑏𝑙𝑒𝑑 + 1) ∗ 𝑎𝑐𝑐𝑢𝑚𝑢𝑙𝑎𝑡𝑖𝑜𝑛𝑠 ∗ 𝑜𝑣𝑒𝑟𝑠𝑎𝑚𝑝𝑙𝑖𝑛𝑔𝑠
 

For example, for a 16° Leddar Vu8 with 256 accumulations and an oversampling value of 8: 

𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑚𝑒𝑛𝑡 𝑟𝑎𝑡𝑒 =  
10000

(8 + 1) ∗ 256 ∗ 8
= 0.5425 Hz 

The data processing time is not taken into account in this calculation. Hence, the actual measurement will 
almost always be lower than the theoretical value. The actual measurement rate depends on the complexity 
of the scene, and the algorithms enabled. 

Refer to section “4.3.2 Enabling and Disabling Segments” on page 37 for more details. 

Table 12 below shows the measurement rate for typical accumulation and oversampling values. 

Table 12: Theoretical measurement rate for Leddar Vu8 

Accumulation Oversampling 
Measurement Rate (Hz) 

16° FoV 48° FoV 99° FoV 

1024 8 0.1356 0.2713 0.5425 

512 8 0.2713 0.5425 1.0851 

256 8 0.5425 1.0851 2.1701 

128 8 1.0851 2.1701 4.3403 

64 8 2.1701 4.3403 8.6806 

32 8 4.3403 8.6806 17.3611 

1024 4 0.2713 0.5425 1.0851 

512 4 0.5425 1.0851 2.1701 

256 4 1.0851 2.1701 4.3403 

128 4 2.1701 4.3403 8.6806 

64 4 4.3403 8.6806 17.3611 

32 4 8.6806 17.3611 34.7222 
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4.5. CPU Load 

The measurement rate varies with the accumulation and oversampling settings. The higher the rate, the 
higher the processing load is on the source and control assembly microcontroller. The Points parameter, in 
the Acquisition Settings dialog box (Device menu, Configuration > Acquisition), also has an impact on 
the processing load since it affects the number of sample points to process for each segment. 

Given the high flexibility of parameter settings, it is possible to create a processing load that exceeds the 
capacity of the microcontroller. When the microcontroller load is exceeded, the theoretical measurement rate 
will not be obtained. 

The load (CPU Load) is displayed in the Device State window (View menu > State). It is recommended to 
verify the load when modifying the Accumulation, Oversampling and Points parameters. The 
measurement rate will be lower than the calculated rate, and the measurement period may be irregular when 
the load nears or reaches 100%. 

 

Fig. 23: Device State window 
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5. Communication Interfaces 

The interfaces and links are optional and are implemented depending on the configuration. 

5.1. SPI Interface 

The SPI interface on the SPI board is a direct link to the receiver module. 

The SPI interface available with the USB, CAN and serial board is a port connected to the MCU but currently 
not implemented. 

5.1.1. SPI Basics 

The SPI interface uses Configuration mode 0, where data is captured on the rising edge of the clock signal 
and output on the falling. 
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Fig. 24: Standard SPI timing diagram 

Table 13 below lists the basic clock signal modes. 

Table 13: Basic modes 

Mode Clock Polarity (CPOL) Clock Phase (CPHA) 

0 0 0 

1 0 1 

2 1 0 

3 1 1 
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5.1.2. SPI Protocol 

The universal SPI protocol uses a combination of standard commands for flash and SRAM memories. 

Each SPI packet contains a header, a payload and a cyclic redundancy check (CRC). 

The first byte of the header corresponds to an instruction opcode. It is followed by a 24-bit address and the 
16-bit size of the payload. The payload contains several user data bytes. The last 16 bits of the packet are 
the CRC16 (IBM) of both the header and payload. Table 14 below summarizes the structure of an SPI packet. 
Noteworthy is that the address and the CRC are packed with the most significant byte first, while the first 
byte of data corresponds to the least significant byte. 

Table 14: Byte offsets 

Field Opcode Address Size Data CRC16 

Byte offset 1 2 3 4 5 6 7 … 7 + n 8 + n 9 + n 

The supported opcodes are listed in Table 15 below. 

Table 15: SPI opcode commands 

Mnemonic Opcode Operation Description 

READ 0x0B Read data 

The “Read” command returns data from memory starting 
at the selected address. It needs a delay between the 
group containing the opcode, address and size data, and 
the return data stream to let the receiver module decode 
the request and get the ready data to the clock. 

WRITE 0x02 Write data 
The “Write” command writes data to memory starting at 
the selected address and is limited to a page of 1 to 512 
bytes. 

CE 0xC7 Reset configuration 

The “Reset” command resets the module to the default 
configuration. The process is started on de-assert of nCS 
and the write-enable flag in the status register must be 
asserted. 

RDSR 0x05 Read status register 
The “Read status” command returns a byte of the status 
register and bit-field flags (see Table 16). 

WREN 0x06 Write enabled 
The “Write enabled” command disables the write 
protection to modify any parameters. 

WRDIS 0x04 Write disabled 
The “Write disabled” command enables the write protec-
tion to lock the module from any parameter changes. 

SOFTRST 0x99 Software reset 
The “Software reset” command resets the receiver 
module. 
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The status register and bit flags are listed in Table 16 below. 

Table 16: Status register 

Bit Name Access Description 

7:2 Reserved R/W Reserved for future use 

1 Write enable latch R 
0 = Write disabled 

1 = Write enabled 

0 Module ready R 
0 = Module ready 

1 = Module busy (programming, erasing) 
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Data chronograms are shown in Fig. 25 and Fig. 26 below, while opcode and register chronograms are shown in Fig. 27 and Fig. 28. 

 

Fig. 25: Read-data chronogram 

 

Fig. 26: Write-data chronogram 

 

Fig. 27: Single-opcode chronogram (write-enabled example) 

 

Fig. 28: Read status register chronogram 
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5.1.3. Memory Map 

The memory map is divided into four memory banks. This section describes the four memory banks in a 
table format. 

Table 17: Memory banks 

Bank Number Start Base Address Bank Size (kB) Access Description 

0 0x00000000 1024 R/W Configuration data 

2 0x00200000 512 R/W Configuration data 

6 0x00400000 128 Read-only 
General device information and 
constants 

10 0x00480000 128 R/W General status 

12 0x004C0000 128 R/W Leddar Vu8 status 

14 0x00500000 1024 Read-only Detection list 

21 0x00FFFB00 1 R/W Transaction configuration 

Configuration data 

Table 18: Configuration data bank 

Offset Length Type Description 

0 32 char Module name as an ASCII string 

32 1 uint8_t Accumulation exponent: for example, 3 = 23 = 8 

33 1 uint8_t Oversampling exponent: for example, 3 = 23 = 8 

34 1 uint8_t Base point sample 

35 4 uint32_t Bit field of segment enabled 

39 4 uint32_t Acquisition rate of the reference pulse 

43 4 float Yaw angle of the module 

47 4 float Pitch angle of the module 

51 4 float Roll angle of the module 

55 4 float X-axis position of the module 

59 4 float Y-axis position of the module 

63 4 float Z-axis position of the module 

67 1 int8_t 
Precision (smoothing): stabilizes the sensor measurements. The 
behavior of the smoothing algorithm can be adjusted by a value ranging 
from –16 to 16. 

68 1 uint8_t Precision enabled 

69 1 uint8_t Saturation compensation enabled 

70 1 uint8_t Overshoot management enabled 
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Offset Length Type Description 

71 4 int32_t 
Sensitivity (detection threshold) setting expressed in a raw amplitude 
scale 

75 1 uint8_t Light source power (0 to 100) 

76 1 uint8_t 

Auto light source power: 

0 = Disabled 

1 = Mode 1 

2 = Mode 2 

77 2 uint16_t 
Auto frame average: changes the delay in the number of measure-
ments. This is the responsivity of the auto light source power according 
to the number of frames. 

79 1 uint8_t 

Auto detections average: number of detections for saturation ac-
ceptance (the number of detections can be saturated to avoid de-
creasing the light source power when using the Automatic mode). This 
is the responsivity of the auto light source power according to the 
number of detections. 

80 1 uint8_t Object demerging enabled 

81 1 uint8_t Static noise removal enabled 

Product configuration 

Table 19: Product configuration data bank 

Offset Length Type Description 

0 1 uint8_t Crosstalk removal enabled 

1 1 uint8_t Crosstalk echo removal enabled 

Device information and constants 

Table 20: Device information and constants bank 

Offset Length Type Description 

0 32 char Module part number as an ASCII string 

32 32 char Software part number as an ASCII string 

64 32 char Module serial number as an ASCII string 

96 32 char Manufacturer name as an ASCII string 

128 32 char Group identification number as an ASCII string 

160 32 char Build date as an ASCII string 

192 32 char Firmware version as an ASCII string 

224 32 char Bootloader version as an ASCII string 

256 32 char ASIC version as an ASCII string (optionally filled according to the module) 

288 32 char FPGA version as an ASCII string 
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Offset Length Type Description 

320 2 uint16_t 

Module type: 

0x00000000 = Invalid device 

0x00000007 = M16 Evaluation Kit 

0x00000008 = IS16 

0x00000009 = M16 

0x0000000A = LeddarOne 

0x0000000D = Leddar Vu8 

322 4 uint32_t Internal use 

326 1 uint8_t Accumulation exponent min. 

327 1 uint8_t Accumulation exponent max. 

328 1 uint8_t Oversampling exponent min. 

329 1 uint8_t Oversampling exponent max. 

330 1 uint8_t Base point sample min. 

331 1 uint8_t Base point sample max. 

332 2 uint16_t Number of vertical segments 

334 2 uint16_t Number of horizontal segments 

336 2 uint16_t Number of reference segments 

338 4 uint32_t Base point sample distance 

342 4 uint32_t 
Reference segment mask: bit-field mask indicates the position of the 
reference segments. 

346 2 uint16_t Number of samples max. 

348 1 uint8_t Internal use 

349 4 uint32_t Clock frequency 

353 1 uint8_t Maximum number of detections per segment 

354 4 uint32_t Distance scale 

358 1 uint8_t 
Raw amplitude scale bit, to which 0xd must be added (amplitude scale 
given in bitshift). I.e., raw amplitude << (scale bit + 0x0d). 

359 4 uint32_t Raw amplitude scale, to which the value 8192 must be added. 

363 2 int16_t Precision min. 

365 2 int16_t Precision max. 

367 4 int32_t Sensitivity min. 

371 4 int32_t Sensitivity max. 

375 1 uint8_t Current light source power count (max. 16) 

376 2 uint16_t Auto frame average min. 

378 2 uint16_t Auto frame average max. 

380 1 uint8_t Auto light source power percent min. 
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Offset Length Type Description 

381 1 uint8_t Auto light source power percent max. 

382 1 uint8_t Auto detections average min. 

383 1 uint8_t Auto detections average max. 

384 1 uint8_t 

Static noise calibration source: 

0 = By end user 

1 = By factory 

385 4 uint32_t CPU load scale 

389 4 uint32_t Temperature scale 

Leddar Vu8 device information and constants 

Table 21: Device information and constants 

Offset Length Type Description 

0 1 uint8_t 
Sensor temperature scale exponent 

Sensor temperature scale = 2^ contents of this register 

General status 

Table 22: General status 

Offset Length Type Description 

0 1 uint8_t 
Detection ready flag: for Polling mode, detections are ready to be read if 
set to 1. 

37 4 uint32_t 
CPU load 

%CPU load = contents of this register / CPU load scale 

75 4 uint32_t Binary CRC32 

Leddar Vu8 status 

Table 23: Leddar Vu8 status 

Offset Length Type Description 

0 4 uint32_t 

Sensor temperature 

Temperature = contents of this register / (2^ sensor temperature scale 
exponent) 

Detection list 

Table 24: Detection list bank 

Offset Length Type Description 

0 4 uint32_t Timestamp in ms since power-up 

4 2 uint16_t Number of detections (N) 
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Offset Length Type Description 

6 2 uint16_t Current percentage of light source power 

8 4 uint32_t Acquisition options 

12 
N* detec-
tion struc-
ture size 

Array of 
detection 
structure 

Start of detection list array 

See Table 25 for details. 

Detection structure size 

Table 25: Detection structure size 

Offset Length Type Description 

0 4 uint32_t 
Distance expressed in distance scale 

To convert to meters, the distance must be divided by the distance scale. 

4 4 uint32_t 

Amplitude expressed in raw amplitude scale 

To convert the amplitude to counts, it must be divided by the amplitude 
scale. 

Amplitude = contents of this register / (amplitude scale register + 8192) 

8 2 uint16_t Segment number 

10 2 uint16_t 

Bit-field detection flag: 

Bit 0: Detection is valid (will always be set) 

Bit 1: Detection is the result of object demerging 

Bit 2: Reserved 

Bit 3: Detection is saturated 

Bit 4: Reserved 

Bit 5: Reserved 

Bit 6: Detection is within the crosstalk zone 

Bit 7: Reserved 

Transaction configuration 

Table 26: Transaction configuration bank 

Offset Length Type Description 

0 1 uint8_t 

Secure-transaction enabled flag: 

1 = Enables the CRC calculation and validation on any transaction. 
This flag is enabled by default. 

0 = No CRC validation. The CRC field is still required in SPI protocol 
but can be set to any value. 
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Offset Length Type Description 

1 1 uint8_t 

Transaction mode: 

0 = Free run. The READY pin is asserted on each ready detection 
frame. The host must be able to read data on time. 

1 = Blocking read. On the READY pin assertion, host must read all data 
from traces or detections bank (data transaction control source 
configuration) to continue acquisition. 

2 = Partial blocking read. On the READY pin assertion, host can read 
all data from traces of the detection bank and the acquisition is still 
running. Possible loss of detection frames if the host reading data is 
very long. 

2 2 uint16_t CRC of the last transaction 

4 2 uint16_t 

Bit-field information of last transactions: 

All bits to 0: No transaction error 

Bit 0: Access right violation 

Bit 1: Invalid address 

Bit 2: Command not found 

Bit 3: Write disabled 

Bit 4: CRC failed 

Bit 5: Command execution error 

Bit 6: Invalid packet 

6 1 uint8_t 

Data transaction control source: 

0 = On trace 

1 = On detections 

This register determines which data type will control the READY pin and 
manage the transaction mode. 

5.1.4. SPI Operation 

The SPI operation includes four parameters: SPI port configuration, speed and timing, access and 
modification. 

5.1.4.1. SPI Port Configuration 

The SPI port must be configured in the 0 mode (see section “5.1.1 SPI Basics” on page 41) to communicate 
with the receiver module. 

5.1.4.2. Sensor Hard Reset 

A hard-reset pin is available to reboot the sensor. The standard hard reset chronogram is shown in Fig. 29 
below: the nCS must not be asserted during this reset sequence. The minimum reset state time (Trst) is 
1 millisecond. The minimum wait time after reset state release (Twait) is 100 milliseconds. 
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Fig. 29: Standard hard reset chronogram 

To prevent the receiver module to go into bootloader mode, the port must never have all SPI input pins (nCS, 
MOSI and CLK) set to the low level for more than 100 milliseconds at power-up or when performing a hard 
reset. 

5.1.4.3. Speed and Timing 

For the read operation, a delay is needed between the header (group containing the opcode, address and 
size data) and the return data stream to let the receiver module decode the request and get the ready data 
to the clock. This delay can be set to 1 millisecond. During this delay, the SPI clock must be halted and the 
nCS must be staying asserted (see Fig. 25). 

The SPI clock frequency can be in the range between 500 kHz and 25 MHz. 

5.1.4.4. Access 

To access a parameter, you need to add a parameter offset to the associated bank start base address. Use 
the parameter length to get or set the whole parameter field. 

5.1.4.5. Modification 

To modify a parameter: 

1. Disable the write protection of the module by sending the “Write enabled” command. 

2. Poll the status register to get the ready state and write enabled flag asserted. 

3. Send the new parameter value. 

4. Poll the status register to get the ready state. 

5. Send the “Write disabled” command (write protection) to prevent any unwanted parameter change. 

 

To prevent any data corruption or loss after modifying a parameter or a firmware update, 
the module must be in the ready state before shutting it down or doing a hard reset. 

5.2. I2C Interface 

The I2C interface on the SPI board is a direct link to the receiver and source modules. For the moment, only 
the temperature sensor is accessible. Refer to the LM75BIMM-3/NOPB temperature sensor data sheet from 
Texas Instruments. 

The I2C interface available with the enhanced board is a port connected to the MCU but currently not 
implemented. 



 

52 | 110 © 2021 LeddarTech Inc. 

5.3. USB Interface 

The USB interface available with the USB, CAN and serial board is a VCP (virtual COM port) serial emulation 
port. This port is used as a serial link with the Modbus protocol (see section 5.4 below). This interface can 
also be used to update the USB, CAN and serial board firmware in bootloader mode. 

5.4. Serial Link Interface 

The serial links can be of the following electric signals: TTL, RS-232, RS-422 and RS485. 

The serial link ports use the Modbus protocol using the RTU transmission mode only. This section describes 
the commands that are implemented. 

For more information on the Modbus protocol, go to www.modbus.org. 

Read input register (function code 0x4) 

The following table lists the registers for the “Read input” commands. 

Table 27: Read input register message 

Address Description 

1 

Detection status for Polling mode: 

0 = Detections not ready 

1 = Detections ready: this status flag is reset to 0 after reading this 
register 

2 Number of segments (N) 

11 Number of detections 

12 Current percentage of light source power 

13 Bit field of acquisition status: Reserved. 

14 
Low 16 bits of timestamp (number of milliseconds since the module 
was started) 

15 High 16 bits of timestamp 

16 to 16 + N-1 
Distance of the first detection for each segment, zero if no detection in 
a segment. The distance unit is defined by the serial port parameters. 

16 + N to 16 + (2*N) – 1 
Amplitude of first detection for each segment times 64 (i.e., amplitude 
= this register / 64), zero if no detection in a segment 

16 + (2*N) to 16 + (3*N) – 1 

Flag of the first detection for each segment: 

Bit 0: Detection is valid (will always be set) 

Bit 1: Detection is the result of object demerging 

Bit 2: Reserved 

Bit 3: Detection is saturated 

Bit 4: Reserved 

Bit 5: Reserved 

Bit 6: Detection is within the crosstalk zone 

Bit 7: Reserved 

16 + (3*N) to 16 + (4*N) – 1 Distance of the second detection for each segment 

file:///C:/Users/user366/Documents/My%20Deliverables/User%20Guides/2D%20Modules/Leddar%20Vu8/www.modbus.org
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Address Description 

16 + (4*N) to 16 + (5*N) – 1 Amplitude of the second detection for each segment 

16 + (5*N) to 16 + (6*N) – 1 Flag of the second detection for each segment 

16 + (6*N) to 16 + (7*N) – 1 Distance of the third detection 

16 + (7*N) to 16 + (8*N) – 1 Amplitude of the third detection 

16 + (8*N) to 16 + (9*N) – 1 Flag of the third detection 

16 + (9*N) to 16 + (10*N) – 1 Distance of the fourth detection 

16 + (10*N) to 16 + (11*N) – 1 Amplitude of the fourth detection 

16 + (11*N) to 16 + (12*N) – 1 Flag of the fourth detection 

16 + (12*N) to 16 + (13*N) – 1 Distance of the fifth detection 

16 + (13*N) to 16 + (14*N) – 1 Distance of the fifth detection 

16 + (14*N) to 16 + (15*N) – 1 Flag of the fifth detection 

16 + (15*N) to 16 + (16*N) – 1 Distance of the sixth detection 

16 + (16*N) to 16 + (17*N) – 1 Amplitude of the sixth detection 

16 + (17*N) to 16 + (18*N) – 1 Flag of the sixth detection 

 

 
As per the Modbus protocol, register values are returned in big-endian format. 

For an example of a 0x04 Modbus function (read input register), refer to Appendix A on page 104. 

Read holding register (function code 0x3), write register (function code 0x6), write multiple register 
(function code 0x10) and read/write multiple register (function code 0x17) 

The following table lists the registers for these commands (see section 4.3 for a more detailed description of 
parameters). 

Table 28: Read holding register message definition 

Address Description 

0 
Exponent for the number of accumulations (i.e., if the content of this register is n, 2n accu-
mulations are performed) 

1 
Exponent for the number of oversamplings (i.e., if the content of this register is n, 2n over-
samplings are performed) 

2 Number of base samples 

3 Reserved 

4 
Detection threshold as a fixed-point value with a 6-bit fractional part (i.e., the threshold value 
is this register divided by 64) 
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Address Description 

5 

Light source power as a percentage of maximum. A value above 100 is an error. If a value is 
specified that is not one of the predefined values, the closest predefined value will be used. 
Refer to the detection reading to verify the light source Intensity value as shown in Table 27 
and Table 31. 

6 

Bit field of acquisition options: 

Bit 0: Automatic light source power enabled 

Bit 1: Object demerging enabled 

Bit 2: Static noise removal enabled 

Bit 3: Precision (smoothing) enabled 

Bit 4: Saturation compensation enabled 

Bit 5: Overshoot management enabled 

Bit 6: Automatic light source power mode: 

0 = Mode 1 

1 = Mode 2 

Bit 7: Crosstalk removal enabled 

Bit 8: Crosstalk echo removal enabled 

7 Auto light source power change delay in number of measurements 

8 Reserved 

9 
Number of echoes for saturation acceptance: the number of echoes can be saturated to 
avoid decreasing the light source power in Automatic mode. 

10 

Operation mode 

Write mode: 

0 = Stop (stop acquisition) 

1 = Continuous 

2 = Single (acquisition of a single detection frame) 

Read mode: 

10 = Stopped (sensor is stopped) 

11 = Continuous acquisition mode 

12 = Single frame busy (acquisition in progress) 

13 = Sensor is busy 

11 
Smoothing: stabilizes the sensor measurements. The behavior of the smoothing algorithm 
can be adjusted by a value ranging from –16 to 16. 

12 Low 16 bits of segment enabled: bit field of enabled segment 

13 High 16 bits of segment enabled 

 

 
As per the Modbus protocol, register values are returned in big-endian format. 

A request for a register that does not exist will return error code “2.” Trying to set a register to an invalid value 
will return error code “3.” If an error occurs while trying to execute the function, error code “4” will be returned. 
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Report server ID (function code 0x11) 

This function returns information on the Leddar Vu8 module in the following format: 

Table 29: Report server ID message 

Offset Length Description 

0 1 
Number of bytes of information (excluding this one). Currently 0x99 since the size 
of the information returned is fixed. 

1 32 Serial number as an ASCII string 

33 1 
Run status 0: OFF, 0xFF: ON. Should always return 0xFF, otherwise the module is 
defective. 

34 32 Device name as an ASCII string 

66 32 Hardware part number as an ASCII string 

98 32 Software part number as an ASCII string 

130 8 Full firmware version as four 16-bit values 

138 48 Full bootloader version as four 16-bit values 

146 2 FPGA build version 

148 4 Internal use 

152 2 Device identification code (13 for Leddar Vu8) 

Get detections (function code 0x41) 

This function returns the detections/measurements in the following format: 

The first byte is the number of detections in the message. Because of the limitation on a Modbus message 
length, a maximum of 40 detections will be returned. 

 

This maximum can be configured to a lower value using the Leddar Configurator software 
(serial port configuration) or the Write Register command described below. 

Following the first byte, each detection has six bytes (see Table 30). 

Table 30: Get detection message (detection fields) 

Offset Length Description 

0 2 The distance (little-endian). Distance unit is defined by serial port parameters. 

2 2 The amplitude times 64 [i.e., amplitude = this field / 64 (little-endian)] 

4 1 

Four bits are flags describing the measurement (all others are reserved): 

Bit 0: Detection is valid (will always be set) 

Bit 1: Detection is the result of object demerging 

Bit 3: Detection is saturated 

Bit 6: Detection is within the crosstalk zone 

5 1 Segment number 
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Three more data fields follow the detection list: 

Table 31: Get detection message (trailing fields) 

Offset Length Description 

0 4 
Timestamp of the acquisition (little-endian), expressed as the number of 
milliseconds since the device was started 

4 1 Current light source power as a percentage of maximum 

5 2 Bit-field acquisition. Reserved. 

For an example of a 0x41 Modbus function, refer to Appendix B on page 106. 

Read module data (function code 0x42) 

Table 32 and Table 33 list the request and answer codes for reading data. This function is an encapsulation 
of the SPI protocol. See section “5.1.3 Memory Map” above. 

Table 32: Requests 

Offset Length Description 

0 4 Base address: 0x00000000 to 0x00FFFFFF (little-endian) 

4 1 Number of bytes to read: 1 to 247. 

Table 33: Answers 

Offset Length Description 

0 4 Base address: 0x00000000 to 0x00FFFFFF (little-endian) 

4 1 Number of bytes read: 1 to 247. 

5 Nb * 1 byte Data 

Write module data (function code 0x43) 

Table 34 and Table 35 list the request and answer codes for writing data. This function is an encapsulation 
of the SPI protocol. See section “5.1.3 Memory Map.” 

Table 34: Requests 

Offset Length Description 

0 4 Base address: 0x00000000 to 0x00FFFFFF 

4 1 Number of bytes written: 1 to 247. 

5 Nb * 1 byte Data 

Table 35: Answers 

Offset Length Description 

0 4 Base address: 0x00000000 to 0x00FFFFFF 

4 1 Number of bytes written: 1 to 247. 
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Send opcode command (function code 0x44) 

Table 36 and Table 37 list the request and answer codes for sending the opcode. This function is an 
encapsulation of the SPI protocol. See section “5.1.3 Memory Map.” 

Table 36: Requests 

Offset Length Description 

0 1 

Opcode. Supported opcodes: 

Read status = 0x05 

Write enabled = 0x06 

Write disabled = 0x04 

Reset configuration = 0xC7 

Soft reset = 0x99 

1 1 Argument: optional value (must be set to 0x00) 

Table 37: Answers 

Offset Length Description 

0 1 Opcode 

1 1 Return value: optional return value (Read status opcode = Status value) 

Get serial port settings (function code 0x45, 0x00) 

Table 38, Table 39 and Table 40 list the requests and answers of the Get serial port settings. 

Table 38: Requests 

Offset Length Description 

0 1 Sub-function code: 0x00 

Table 39: Answers header field 

Offset Length Description 

0 1 Sub-function code: 0x00 

1 1 Number of serial ports 

2 1 
Current logical serial port number (current logical serial number connected to the 
host used for this transaction) 
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Table 40: Answers serial port settings field 

Offset Length Description 

0 1 Logical serial port number 

1 4 

Baud rate. Supported rates: 

9 600 

19 200 

38 400 

57 600 

115 200 

5 1 Date size: 8 = 8-bit size 

6 1 

Parity: 

0 = None 

1 = Odd 

2 = Even 

7 1 

Stop bit: 

1 = 1 stop bit 

2 = 2 stop bits 

8 1 Flow control: 0 = None 

9 1 Modbus address: 1 to 247. 

10 1 
Max. echoes per transaction. Used for the Get Detection command (function code 
0x41), max. 40 echoes. 

11 2 

Distance resolution: 

1 = m 

10 = dm 

100 = cm 

1 000 = mm 

 

 

This answer table is repeated by the number of available serial ports. 

Set serial port settings (function code 0x45, 0x01) 

Table 41, Table 42 and Table 43 list the requests and answers for the Set serial port settings. 

Table 41: Requests header field 

Offset Length Description 

0 1 Sub-function code: 0x01 
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Table 42: Requests serial port setting field 

Offset Length Description 

0 1 Settings of the corresponding logical serial port number to set 

1 4 

Baud rate. Supported rates: 

9 600 

19 200 

38 400 

57 600 

115 200 

5 1 Date size: 8 = 8-bit size 

6 1 

Parity: 

0 = None 

1 = Odd 

2 = Even 

7 1 

Stop bit: 

1 = 1 stop bit 

2 = 2 stop bits 

8 1 Flow control: 0 = None 

9 1 Modbus address: 1 to 247. 

10 1 
Max. echoes per transaction. Used for the Get Detection command (function code 
0x41), max. 40 echoes. 

11 2 

Distance resolution: 

1 = m 

10 = dm 

100 = cm 

1 000 = mm 

 

 

This request table can be repeated by the number of available serial ports (by using the 
corresponding logical port number). 

Table 43: Answers 

Offset Length Description 

0 1 Sub-function code: 0x01 

Get carrier firmware information (function code 0x45, 0x02) 

Table 44 and Table 45 list the registers for the Firmware information commands. 
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Table 44: Requests 

Offset Length Description 

0 1 Sub-function code: 0x02 

Table 45: Answers 

Offset Length Description 

0 1 Sub-function code: 0x02 

1 32 Firmware part number as an ASCII string 

33 8 Firmware version in four units for format A, B, C and D. 

Get carrier device information (function code 0x45, 0x03) 

Table 46 and Table 47 list the registers for the Carrier device information commands. 

Table 46: Requests 

Offset Length Description 

0 1 Sub-function code: 0x03 

Table 47: Answers 

Offset Length Description 

0 1 Sub-function code: 0x03 

1 32 Hardware part number as an ASCII string 

33 32 Hardware serial number as an ASCII string 

65 4 Option bits. Reserved for LeddarTech use. 

Get CAN port settings (function code 0x45, 0x04) 

Table 48, Table 49 and Table 50 list the requests and answers of the Get CAN port settings. 

Table 48: Requests 

Offset Length Description 

0 1 Sub-function code: 0x04 

Table 49: Answers header field 

Offset Length Description 

0 1 Sub-function code: 0x04 

1 1 Number of CAN ports 
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Table 50: Answers CAN port settings field 

Offset Length Description 

0 1 Logical CAN port number settings 

1 4 

Baud rate. Supported rates: 

10 000 

20 000 

50 000 

100 000 

125 000 

250 000 

500 000 

1 000 000 

5 1 

Frame format: 

0 = Standard 11 bits 

1 = Extended 29 bits 

6 4 Tx base ID 

10 4 Rx base ID 

14 1 
Maximum number of detections (measurements) returned per CAN detection 
message transaction: 1 to 96. 

15 2 

Distance resolution: 

1 = m 

10 = dm 

100 = cm 

1 000 = mm 

17 2 Inter-message delay (0 to 65 535 milliseconds) 

19 2 Inter-cycle delay (0 to 65 535 milliseconds) 

 

 

This answer table is repeated by the number of available CAN ports. 

Set CAN port settings (function code 0x45, 0x05) 

Table 51 and Table 52 list the requests and answers for the CAN port commands. 

Table 51: Requests header field 

Offset Length Description 

0 1 Sub-function code: 0x05 
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Table 52: Requests CAN port settings field 

Offset Length Description 

0 1 Settings of the corresponding logical CAN port number to set 

1 4 

Baud rate. Supported rates: 

10 000 

20 000 

50 000 

100 000 

125 000 

250 000 

500 000 

1 000 000 

5 1 

Frame format: 

0 = Standard 11 bits 

1 = Extended 29 bits 

6 4 Tx base ID 

10 4 Rx base ID 

14 1 
Maximum number of detections (measurements) returned per CAN detection 
message transaction: 1 to 96. 

15 2 

Distance resolution: 

1 = m 

10 = dm 

100 = cm 

1 000 = mm 

17 2 Inter-message delay (0 to 65 535 milliseconds) 

19 2 Inter-cycle delay (0 to 65 535 milliseconds) 

 

 

This request table can be repeated by the number of available CAN ports (by using the 
corresponding logical port number). 

Table 53: Answers 

Offset Length Description 

0 1 Sub-function code: 0x05 
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5.5. CAN Bus Interface 

The CAN bus interface uses two default message IDs that can be modified by the user: 1856 (0x740) and 
1872 (0x750). 

Four message IDs are available: 

Table 54: CAN message IDs 

Message ID Direction Data Type 

0x740 Rx Request from a host 

0x750 Tx Answer to a host request 

0x751 Tx Number of detection messages 

0x752 and over Tx Detection messages 

1856 (0x740) (Rx base ID) 

These are 8-byte length messages for command requests that the module monitors: the first byte (byte 0) 
describes the main function and the rest of the message bytes are used as arguments. Undescribed bytes 
are reserved and must be set to 0. 

The module answer messages are described in section 1872 (0x750) (Tx base ID). 

Table 55: CAN bus request message 

Function Re-
quest (Byte 0) 

Function Request Description Function Arguments (Byte 1) 

1 Stop sending detections continuously -- 

2 Send detection once 

Bit field of operation mode 

Bit 0: 

0 = Return detection in single-message mode 

1 = Return detection in multiple-message mode 

3 

Start sending detections continuously 
(i.e., the module will send a new set 
of detections each time they are 
ready without waiting for a request) 

Bit field of operation mode 

Bit 0: 

0 = Return detection in single-message mode 

1 = Return detection in multiple-message mode 

4 Get input data (read-only) See Table 56. 

5 Get holding data See Table 57. 

6 Set holding data See Table 58. 

7 Set base address See Table 59. 

8 Read module data See Table 60. 

9 Write module data See Table 61. 

10 Send module opcode command See Table 62. 
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Table 56: CAN bus request message (Get input data) 

Input Data 
Type (Byte 1) 

Input Data Description 

0 Number of segments 

1 Device identification and option 

2 and 3 Firmware version 

4 and 5 Bootloader version 

6 FPGA version 

7 to 12 Serial number 

13 to 18 Device name 

19 to 24 Hardware part number 

25 to 30 Software part number 

Table 57: CAN bus request message (Get holding data) 

Holding Data 
Type (Byte 1) 

Holding Data Description 

0 Acquisition configuration 

1 Smoothing and detection threshold 

2 Light source power management 

3 Distance resolution and acquisition options 

4 CAN port configuration 1 

5 CAN port configuration 2 

6 CAN port configuration 3 

7 Reserved 

8 Segment enabled 

Table 58: CAN bus request message (Set holding data) 

Holding Data 
Type (Byte 1) 

Holding Data Description Argument Argument Description 

0 Acquisition configuration 

Byte 2 
Exponent for the number of accumulations 
(i.e., if the content of this register is n, 2n 
accumulations are performed) 

Byte 3 
Exponent for the number of oversamplings 
(i.e., if the content of this register is n, 2n 
oversamplings are performed) 

Byte 4 Number of base samples 
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Holding Data 
Type (Byte 1) 

Holding Data Description Argument Argument Description 

1 
Smoothing and detection 
threshold 

Byte 2 

Smoothing: stabilizes the sensor measure-
ments. The behavior of the smoothing algo-
rithm can be adjusted by a value ranging 
from −16 to 16. Clear the Enable check 
box to disable smoothing. 

Bytes 4 to 7 
Detection threshold as a fixed-point value 
with a 6-bit fractional part (i.e., threshold 
value is this register divided by 64) 

2 
Light source power 
management 

Byte 2 

Light source power as a percentage of 
maximum. A value above 100 is an error. If 
a value is specified that is not one of the 
predefined values, the closest predefined 
value will be used. Refer to the detection 
reading to verify the light source Intensity 
value as shown in Table 55 and Table 67. 

Note that this value is ignored if the Auto-
matic light source power is enabled. 

Byte 3 

Number of echoes for saturation ac-
ceptance: the number of echoes can be 
saturated to avoid decreasing the light 
source power when using the Automatic 
mode. 

Bytes 4 
and 5 

Auto light source power changes the delay 
in number of measurements. 

3 
Distance resolution and 
acquisition options 

Bytes 2 
and 3 

Distance unit: 

1 = m 

10 = dm 

100 = cm 

1 000 = mm 

Bytes 4 
and 5 

Bit field of acquisition options: 

Bit 0: Automatic light source power enabled 

Bit 1: Object demerging enabled 

Bit 2: Static noise removal enabled 

Bit 3: Precision (smoothing) enabled 

Bit 4: Saturation compensation enabled 

Bit 5: Overshoot management enabled 

Bit 6: Automatic light source power mode: 

0 = Mode 1 

1 = Mode 2 

Bit 7: Crosstalk removal enabled 

Bit 8: Crosstalk echo removal enabled 
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Holding Data 
Type (Byte 1) 

Holding Data Description Argument Argument Description 

4 CAN port configuration 1 

Byte 2 

Baud rate (kbps): 

0 = 1 000 

1 = 500 

2 = 250 

3 = 125 

4 = 100 

5 = 50 

6 = 20 

7 = 10 

Byte 3 

Frame format: 

0 = Standard 11 bits 

1 = Extended 29 bits 

Bytes 4 to 7 Tx base ID 

5 CAN port configuration 2 Bytes 4 to 7 Rx base ID 

6 CAN port configuration 3 

Byte 3 
Maximum number of detections (measure-
ments) returned per CAN detection mes-
sage transaction: 1 to 96. 

Bytes 4 
and 5 

Inter-message delay (0 to 65 535 millisec-
onds) 

Bytes 6 
and 7 

Inter-cycle delay (0 to 65 535 milliseconds) 

7 Reserved -- -- 

8 Segment enabled Bytes 4 to 7 Bit field of the enabled segments 

Table 59: CAN bus request message (Set base address) 

Data Description Argument Argument Description 

Base address Bytes 4 to 7 
Base address to access the Read module date and Write module 
date commands (from 0x00000000 to 0x00FFFFFF) 

Table 60: CAN bus request message (Read module data) 

Data Description Argument Argument Description 

Read module data 

Byte 1 Data length (1, 2 or 4) 

Bytes 2 and 3 
Offset from 0x0000 to 0xFFFF (final address to access is the re-
sult of the base address plus this offset). This function is an en-
capsulation of the SPI protocol. See section “5.1.3 Memory Map.” 
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Table 61: CAN bus request message (Write module data) 

Data Description Argument Argument Description 

Write module data 

Byte 1 Data length (1, 2 or 4) 

Bytes 2 and 3 
Offset from 0x0000 to 0xFFFF (final address to access is the 
result of the base address plus this offset). 

Bytes 4 to 7 

Data to write 

This function is an encapsulation of the SPI protocol. See section 
“5.1.3 Memory Map.” 

Table 62: CAN bus request message (Send module opcode command) 

Data Description Argument Argument Description 

Send module 
opcode command 

Byte 2 

Opcode 

This function is an encapsulation of the SPI protocol. See section 
“5.1.2 SPI Protocol.” 

Byte 3 Optional argument (must be set to 0x00) 

1872 (0x750) (Tx base ID) 

These are 8-byte answer messages to the host command requests. 

Table 63: CAN bus answer message 

Answer Data 
(Byte 0) 

Answer Data Description Additional Answer Data (Byte 1 to Byte 7) 

1 
Answer to stop continu-
ously sending detection 
requests 

Success: return echo from the command request. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

2 
Answer to send once a 
detection request 

Success: return echo from the command request. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

3 
Answer to continuously 
send a detection request 

Success: return echo from the command request. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

4 
Answer to the Get input 
data request 

Success: see format in Table 64. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

5 
Answer to the Get holding 
data request 

Success: see format in Table 58. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

6 
Answer to the Set holding 
data request 

Success: return echo of the command request. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

7 
Answer to the Set base 
address request 

Success: return echo of the command request. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

8 
Answer to the Read 
module data request 

Success: see Table 65. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

9 
Answer to the Write 
module data request 

Success: return echo of the command request. 

Fail: all bytes from 2 to 7 are set to 0xFF. 
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Answer Data 
(Byte 0) 

Answer Data Description Additional Answer Data (Byte 1 to Byte 7) 

10 
Answer to the Send 
module opcode request 

Success: see Table 66. 

Fail: all bytes from 2 to 7 are set to 0xFF. 

Table 64: CAN bus answer message (Get input data) 

Input Data 
Type (Byte 1) 

Input Data Description Argument Argument Description 

0 Number of segments Bytes 2 and 3 Number of segments 

1 
Device identification and 
options 

Bytes 2 and 3 
Device identification code (13 for Leddar 
Vu8) 

Bytes 4 to 7 
Module option flags (LeddarTech internal 
use) 

2 
Firmware version in format 
A, B, C, D 

Bytes 2 and 3 Firmware build version (A) 

Bytes 4 and 5 Firmware build version (B) 

Bytes 6 and 7 Firmware build version (C) 

3 
Firmware version in format 
A, B, C, D 

Bytes 2 and 3 Firmware build version (D) 

4 
Bootloader version in 
format A, B, C, D 

Bytes 2 and 3 Bootloader build version (A) 

Bytes 4 and 5 Bootloader build version (B) 

Bytes 6 and 7 Bootloader build version (C) 

5 
Bootloader version in 
format A, B, C, D 

Bytes 2 and 3 Bootloader build version (D) 

6 FPGA version 

Bytes 2 and 3 FPGA version 

Byte 6 

Run status 0: OFF, 0xFF: ON. 

Should always return 0xFF, otherwise the 
module is defective. 

7 to 12 Serial number Bytes 2 to 7 
Serial number as an ASCII string (max. 
32 bytes) 

13 to 18 Device name Bytes 2 to 7 
Device name as an ASCII string (max. 32 
bytes) 

19 to 24 Hardware part number Bytes 2 to 7 
Hardware part number as an ASCII string 
(max. 32 bytes) 

25 to 30 Software part number Bytes 2 to 7 
Software part number as an ASCII string 
(max. 32 bytes) 
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Table 65: CAN bus answer message (Read module data) 

Data Description Argument Argument Description 

Read module 
opcode command 

Byte 1 Data length (1, 2 or 4) 

Byte 2 
Offset 

Byte 3 

Byte 4 

Data to read 
Byte 5 

Byte 6 

Byte 7 

Table 66: CAN bus answer message (Send module opcode request) 

Data Description Argument Argument Description 

Send module 
opcode command 

Byte 2 Opcode 

Byte 3 Optional argument 

Byte 4 Optional return value 

1873 (0x751) (Tx base ID + 1) 

These are 8-byte messages that indicate the number of detections that will be sent. 

Table 67: CAN bus number of detection messages 

Data Data Return Description 

Byte 0 Number of detections 

Byte 1 Current light source power as a percentage of maximum 

Byte 2 
Status of the bit-field acquisition: Reserved. 

Byte 3 

Bytes 4 to 7 
Timestamp of the acquisition, expressed as the number of milliseconds since the 
module was started. 

1874 (0x752) (Tx base ID + 2) 

These are the detection messages with flag information, containing one detection presented in the following 
format: 

• Data bytes 0 and 1 contain the distance in units defined by the distance-units holding data. 

• Data bytes 2 and 3 contain the amplitude. This value must be divided by 64 to provide the amplitude 
(i.e., 6 bits for the fractional part). 

• Data bytes 4 and 5 contain the flag information as described in the table below. 

• Bytes 6 and 7 contain the segment number. 
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Table 68: Flag information of measurement 

Data Description 

Bit 0 Detection is valid (will always be set). 

Bit 1 Detection was the result of object demerging. 

Bit 2 Reserved 

Bit 3 Detection is saturated. 

Bits 4-5 Reserved 

Bit 6 Detection is within the crosstalk zone. 

Bit 7-15 Reserved 

Detection messages can be sent in two modes: as a single-message ID or a multiple-message ID. 

For the single-message ID mode, all detection messages are sequentially sent on the same message ID; 
i.e., 1874 (0x752). 

For the multiple-message ID mode, detections are sent on message IDs ranging from 1874 to the number 
of detections (1874 + number of detections). The range of message IDs can be limited by the maximum 
number of detections to output to the CAN port (defined in CAN configuration 3 holding data for a maximum 
configurable of 96 detections). 

The following are examples of message IDs for the 1874 base (with a 19-detection frame): 

• From 1874 to 1893 

• From 1874 to 1890, for a module setup with a maximum number of 16 detections. 

For an example of a Leddar Vu8 CAN bus, refer to Appendix C on page108. 
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6. Leddar Configurator 

The Leddar™ Configurator provides configuration parameters and operation functionalities for Leddar™ 
products. 

6.1. Introduction 

The Leddar Configurator interface can be resized manually or set to full-screen view. 

All dialog boxes that do not include a selection of action buttons at the bottom, such as Connect, OK, Cancel, 
etc., are dockable at the top, the bottom or on the right side of the main window. 

 

Fig. 30: Raw Detections dialog box docked on the side of the main window 

When a dialog box or a window is already open, a check mark appears next to the command on the menu. 

 

Fig. 31: Command check mark 
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6.2. Connection Window 

 

Fig. 32: USB (left) and SPI (right) connection dialog box 

Select a connection type 

The connection type you are using. There are five connection types: 

1. IS16/M16/Evaluation Kit USB/Leddar Sight 

2. Leddar Vu8 SPI 

3. Leddar Vu8 USB/Serial 

4. LeddarAuto 

5. LeddarOne 

Available ports 

The list of available ports displays the modules currently detected. 

 
The descriptions below apply to the Leddar Vu8 USB/Serial connection type. 
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6.3. Leddar Configurator Main Window 

After connecting to the device, the main window opens. 

 

Fig. 33: Leddar Configurator main window 

The measurements are plotted in a symbolic graph containing the eight segments (white lines) originating 
from the sensor. Detections are drawn as arcs in their corresponding segments. Only valid measurements 
are displayed. A more detailed description of the measurements can be obtained in the Raw Detections 
dialog box (see section “6.12 Raw Detections” on page 91). 

The numbers X and Y displayed at the bottom are the mouse cursor position coordinates. 

Display Controls 

Several options are available for adjusting the main window display. 

6.3.1. Fit to Window 

The  Fit to Window icon allows you to expand the display to fit the dimensions of the computer screen. 

6.3.2. Force Equal Horizontal and Vertical Scales 

When the  Equal Scaling icon is selected (icon highlighted), the original ratio of the display is kept or 
restored. The horizontal and vertical scales will be set to the same values, and the beam will be displayed in 
accordance with the beam properties (for example, the display will show a 48° beam for a 48° Leddar Vu8 
module). 

Click the icon again to change the vertical and horizontal scales independently. 

 

When in equal scaling mode, you cannot zoom the display horizontally or vertically, i.e., 
holding the <Control> or <Shift> key down while zooming in or out will have no effect. The 
scales cannot then be modified by entering values in the fields shown in Fig. 33 above. 

Vertical scale 
setting area 

Horizontal scale 
setting area 
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6.3.3. Zoom In 

Click the  Zoom In icon to zoom in vertically and horizontally around the center of the display. 

6.3.4. Zoom Out 

Click the  Zoom Out icon to zoom out vertically and horizontally around the center of the display. 

6.3.5. Scale 

The window opens with the default scale setting. The horizontal and vertical scales can be changed manually 
by entering new values in the fields accessible by clicking the areas shown in Fig. 33. 

To apply the changes, click anywhere in the main window. 

6.3.6. Panning and Zooming 

The display in the main window can be panned and zoomed in different ways. Panning and zooming is done 
relative to the mouse cursor position. 

You can move up, down and sideways by clicking and dragging the display. 

To zoom the display in and out, use the mouse wheel alone. This has the same effect as clicking the  

Zoom In or  Zoom Out icon respectively (see sections 6.3.3 and 6.3.4 above). 

To zoom the display horizontally, hold down the <Control> key of the computer keyboard while using the 
mouse wheel. 

 
The  Equal Scaling icon must be not selected (not highlighted). 

 

Fig. 34: Zooming in (left) and out (right) horizontally 

To zoom the display vertically, hold the <Shift> key down while using the mouse wheel. 
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The  Equal Scaling icon must be not selected (not highlighted). 

 

Fig. 35: Zooming in (left) and out (right) vertically 

The measurements of a detection point appear as a pop-up when you point to it with the mouse cursor for a 
more accurate assessment of the detection. Detection points are shown in the form of green lines (arcs) in 
the main window for visibility reasons. 

 

Fig. 36: Detection point coordinates 
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6.3.7. Changing the Sensor Origin 

The sensor origin can be modified by clicking the sensor origin at the bottom of the segments. 

To do so, use the mouse cursor to point to the bottom of the segments (a red dot appears), then click and 
drag it to the desired position. 

 

Fig. 37: Changing the sensor origin 

If you click and drag the sensor origin, its position is displayed in the status bar, as shown in Fig. 38 below. 

 

Fig. 38: Sensor position display 

To apply the changes, click the  Apply icon. The sensor origin is saved in the module. 
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6.3.8. Changing the Sensor Orientation 

The sensor orientation may be changed to match the physical position of the module. If you do so, the main 
window display can better match the physical installation of the module. For example, if the module is 
installed above the ground, the sensor origin can be set to reflect its position. 

Use the mouse cursor to point to the top of the segments (the top turns red), then click and drag it to the 
desired position. 

 

Fig. 39: Changing the sensor orientation 

To apply the changes, click the  Apply icon. The sensor orientation is saved in the module. 

6.4. Settings 

The Leddar Vu8 stores many settings. Once saved in the module, these parameters are effective at each 
power-up. The Leddar Configurator software loads these parameters upon each connection. 

6.4.1. Device Name 

When you connect to a Leddar Vu8 module for the first time, it has a default name. You can change that 
name at any time. 

To change the device name: 

1. Connect to the device. 
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2. In the Device menu, select Configuration, then click Device Name.... 

 

Fig. 40: Device menu – Changing the device name 

3. In the Name field of the Device Name dialog box, enter the new name of the device and click OK. 

 

Fig. 41: Device Name dialog box 

4. Click the  Apply icon in the Leddar Configurator main window to apply the change. 

6.4.2. Acquisition Settings 

The Acquisition Settings function allows you to define parameters to use for detection and distance 
measurement. 

To open the Acquisition Settings dialog box, select Device, then Configuration, then click Acquisition. 

 

Fig. 42: Acquisition Settings dialog boxes 

To apply the changes, click the  Apply icon in the main window. 

Refer to section 4.3 on page 32 for more details on all the parameters. 
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6.4.3. Serial Ports 

The serial port settings of the USB, CAN and serial board are configurable. 

To configure the serial port: 

1. In the Device menu, select Configuration, then Communication, then click Serial Ports. 

 

Fig. 43: Device menu – Serial ports 

2. In the Serial Ports Settings dialog box, you can change the numbers using the arrows or by entering 
the value manually. 

 

Fig. 44: Serial Ports Settings dialog box 

Table 69: Serial port settings description 

Parameter Value 

Port Number 

Select 1 for the configurable serial link number 1. 

Select 2 for the TTL serial link number 2. 

Select 3 for the USB VCP serial link. 

Baud Rate (bps) 

9 600 

19 200 

38 400 

57 600 

115 200 

Modbus Address 1 to 247 

Maximum Echoes 0 to 40 
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Parameter Value 

Distance Resolution 

Millimeters (mm) 

Centimeters (cm) 

Decimeters (dm) 

Meters (m) 

6.4.4. CAN Ports 

The CAN port settings of the USB, CAN and serial board are configurable. 

To configure the CAN port: 

1. In the Device menu, select Configuration, then Communication, then click CAN Ports. 

 

Fig. 45: Device menu – CAN ports 

2. In the CAN Port Settings dialog box, you can change the numbers using the arrows or by entering the 
value manually. 

 

Fig. 46: CAN Port Settings dialog box 

Table 70: CAN port settings description 

Parameter Value 

Port Number Select 1 for CAN communication. 
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Parameter Value 

Baud Rate (bps) 

10 000 

20 000 

50 000 

100 000 

125 000 

250 000 

500 000 

1 000 000 

Base Tx ID 
The base CAN arbitration ID used for data messages coming from the USB, CAN 
and serial board to the host. The arbitration ID of the messages containing the 
number of detections will be this value plus one (see the protocol documentation). 

Base Rx ID 
The base CAN arbitration ID used for data messages sent to the USB, CAN and 
serial board (see the protocol documentation). 

Frame Format 
Standard 11 bits 

Extended 29 bits 

Inter-Message Delay 0 to 65 535 milliseconds 

Inter-Cycle Delay 0 to 65 535 milliseconds 

Detections 1 to 96 

Distance Resolution 

Millimeters (mm) 

Centimeters (cm) 

Decimeters (dm) 

Meters (m) 

6.5. Saving and Loading a Configuration 

The software configuration for a device can be saved to a file. This enables you to back up settings and 
restore them in case of system failure or in case you want to revert to earlier settings. You can also retrieve 
the configuration that was stored with a record file. 

To save a configuration: 

In the File menu, click Save Configuration.... 

 

Fig. 47: File menu – Saving a configuration 
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To load a configuration: 

In the File menu, click Load Configuration.... 

6.6. Configuring Detection Records 

Detection records provide playback of detections recorded by a device. This visual information can be useful 
for verification, troubleshooting or training purposes. Detection records allow for a full data playback stored 
in a *.ltl file that can later be reloaded and replayed. 

To configure the detection record: 

1. In the Settings menu, click Preferences.... 

 

Fig. 48: Settings menu – Preferences 

2. In the Preferences dialog box, click Recording, then Recorder. 

 

Fig. 49: Preferences dialog box – Recorder 

3. Under Directory, click the Browse… button to select the path to save the detection record file. 

4. In the Maximum file size (MB) box, set the maximum file size using the arrows or by entering the value 
manually. 

5. Under What? select the Log debug information check box. 

6. Under How Long? next to Maximum record time (minutes), set the length of time for recording using 
the arrows or by entering the value manually. At the end of that period, the recording will stop even if 
the file size has not reached its maximum. 

7. Click OK to save the settings. 

A complete description of the elements found in the recording Preferences dialog box follows the next two 
procedures. 
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To start a recording: 

In the File menu, click Start Recording. 

 

Fig. 50: File menu – Starting a recording 

To stop a recording manually: 

In the File menu, click Stop Recording. 

 

Fig. 51: File menu – Stopping a recording 

The following is a description of the elements available in the recording Preferences dialog box. 

Record directory 

The record directory is the folder in which all record files will be saved. These files are in a proprietary format, 
with the extension *.ltl, and can only be opened and viewed with the Leddar Configurator software. 

Maximum file size (MB) 

Record files can be quite large. Set the maximum file size as needed. The recording stops for the current file 
once it reaches the maximum file size and automatically switches the recording to another file. This is to 
keep record files of manageable sizes. 

Log debug information 

This check box is reserved for the use of LeddarTech for debug purposes. 

Maximum record time (minutes) 

The value entered as the Maximum record time defines the length of the time for recording. At the end of 
that period, the recording will stop even if the file size has not reached its maximum. 
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6.7. Using Detection Records 

Once you have completed a recording, you can review it and extract part of the recording. 

The Record Replay dialog box offers the same functions as a regular video player, providing a Stop button, 
a Play button and frame-by-frame Forward and Backward buttons. 

The Position slider lets you move directly to a desired position. 

The Playback Speed slider lets you adjust the speed of the recording playback; faster is to the right. 

The Start, End and Extract buttons allow you to select a portion of the recording and extract it for further 
reference or analysis. 

To play a record: 

1. If you are connected to a device, disconnect from it. 

OR 

Open another Leddar Configurator main window. 

 
The record files can also be opened by double-clicking them. 

2. In the File menu, click Replay.... 

 

Fig. 52: File menu – Replay option 

3. In the Record Replay dialog box, click the Browse… button to select a file. 

 

Fig. 53: Record Replay dialog box 

4. Click the Play button to start the playback. 

5. Select the Loop check box to repeat the playback continuously. 

Play 
button 
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To extract a record file segment: 

1. Set the Position slider to the position where you want the file segment to start and click the Start 
button. 

2. Set the Position slider to the position where you want the file segment to stop and click the End button. 

OR 

Play the record and stop it at a position of interest, then click the Start button; restart playing the record, 
stop it again at a position of interest and then click the Stop button. 

3. Click the Extract button to extract and save that file segment. 

6.8. Data Logging 

The Data Logging function is used to output the data to a .txt file. This file can be imported to a software 
application (such as Microsoft Excel) for offline analysis. 

The duration of the record is indicated in the status bar. 

Each line of the generated text file contains the information related to a single detection. 

Table 71: Field description of the log text file 

Time (msec) Segment [1 8] Amplitude [0 512] Distance (m) Status 

12735204 7 0.9 33.61 1 

In this table: 

• Time indicates the timestamp of the detection from when the sensor was connected to the power 
supply. 

• Segment refers to the location of the detection (line, column). 

• Amplitude of the detection indicates the strength of the returned signal. 

• Distance indicates the distance of the detection in meters or feet depending on the distance unit 
configured in Settings > Preferences… > General > Units. 

• Status corresponds to a flag value. Refer to section “6.12 Raw Detections” for more details. 

To use the Data Logging function: 

1. In the Settings menu of Leddar Configurator, click Preferences.... 

 

Fig. 54: Settings menu – Preferences 

2. In the Preferences dialog box, select Recording, then click Data Logger. 
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Fig. 55: Preferences dialog box – Logging data 

3. Under Directory, click the Browse… button to select the path where you want to save the log and click 
OK. 

4. In the File menu, click Start Data Logging. 

 

Fig. 56: File menu – Starting data logging 

5. To stop recording, click Stop Data Logging in the File menu. 

 

Fig. 57: File menu – Stopping data logging 

A .txt file is saved in the selected directory. 
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6.9. Firmware Update 

1. Connect the Leddar Vu8 to its power supply and to the computer through USB or SPI. 

2. Launch Leddar Configurator and connect to the sensor. 

3. A prompt is displayed, indicating that the carrier board firmware is outdated. 

 

Fig. 58: Carrier Board Firmware Update dialog box 

4. Follow the instructions to perform the firmware update. 

 

It is very important that you follow ESD protection rules when updating the firmware to 
avoid any risk of damage to the sensor circuitry. 

 

Fig. 59: Carrier Board Firmware Update warning 

 

Remember to keep the S3 button pressed while you press S1. See below for the locations 
of the buttons. 

 

Fig. 60: Carrier board – S3 and S1 buttons 

5. At the end of the update, you will need to power-cycle the module and reconnect. 
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6. Upon the second connection, a prompt will be displayed, specifying that the software is not up to date. 

 

Fig. 61: Software update dialog box 

7. Perform the second phase of the update and power-cycle the module again. 

To verify the update, click State in the View menu. The Device State window opens, allowing you to verify 
the following information. 

 

Fig. 62: Device State window 

  

Firmware version 

Carrier board 
firmware version 
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6.10. Device State 

Information about a device is accessible by selecting the State option in the View menu. 

 

Fig. 63: View menu – State 

The Device State window opens. 

 

Fig. 64: Device State window 

Temperature 

The Device parameter indicates the temperature of the device. 

Timers & Load 

This section provides information on the time elapsed since the last sensor reset in days, hours, minutes and 
seconds. 

The CPU Load indicates how much of the sensor processor capacity is in use. When the load reaches nearly 
100%, the processor may no longer be able to process all the data. The effective frame rate may be impacted. 

The Measurement Rate indicates the rate at which the sensor measures the speed and dimension of static 
or moving objects. A Measurement Rate in red indicates a significant difference between the optimum and 
current measurement rates. 
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Device Information 

The Serial Number is the serial number of the device as assigned by LeddarTech. 

The Software Version is the software version specific to the processor of the unit. 

The Bootloader Version is the bootloader (booting instructions) version specific to the processor of the unit. 

The FPGA Version is the field-programmable gate array circuit used in the device. 

The Hardware Part Number is the hardware part number of the device as assigned by LeddarTech. 

The Software Part Number is the software part number of the device as assigned by LeddarTech. 

The Manufacturer Name is the name assigned to LeddarTech. 

The Group ID Number is the end-user group unique identifier used for licensing purposes. 

Carrier Board 

The Serial Number is the serial number of the USB, CAN and serial carrier board as assigned by 
LeddarTech. 

The Software Version is the software version specific to the USB, CAN and serial carrier board of the unit. 

The Hardware Part Number is the hardware part number of the USB, CAN and serial carrier board as 
assigned by LeddarTech. 

The Software Part Number is the software part number of the USB, CAN and serial carrier board as 
assigned by LeddarTech. 

Automatic Parameter Values 

The Light Source Intensity indicates the intensity of the laser. 

6.11. Preferences 

Preferences are used to change various settings related to the display of Leddar Configurator. 

Open the Preferences dialog box by clicking the Preferences… option in the Settings menu. 

 

Fig. 65: Preferences dialog box – Windows 

Windows 

The two options allow you to select how the content of the main window will be displayed in Leddar 
Configurator. 

• The Restore window position and size on startup option starts Leddar Configurator at the same 
place on the computer desktop and at the same size it was when it was closed. 

• The Restore window layout on connection option connects at the same size it was and with all 
docked dialog boxes or windows that were displayed when it was closed. 
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Units 

 

Fig. 66: Preferences dialog box – Units 

The unit that is applied to the distances and to the sensor temperature displayed in Leddar Configurator. 

Recording 

The Recorder settings let you choose how data files are recorded (see Fig. 49 on page 82). 

The Data Logger setting lets you select a directory to store logs (see Fig. 55 on page 86). 

Display 

 

Fig. 67: Preferences dialog box – Display 

The Detection Arc Thickness parameter allows you to modify the pixel width of the green detection arcs 
displayed in the main window. You can select a value between 0 and 10. 

6.12. Raw Detections 

The Raw Detections dialog box allows you to view detection values in many ways. It provides filters to 
isolate segments and detection parameters. 

To open the Raw Detections dialog box, select Raw Detections in the View menu. 
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Fig. 68: View menu – Raw Detections dialog box 

Fig. 69 shows an example of raw detections. When there is no detection in some segments, only the 
segments where detection occurred appear in the list. 

 

Fig. 69: Filtering detections in the Raw Detections dialog box 

The following is a description of the parameters in the Raw Detections dialog box. 

Min and Max Amplitude 

The value entered in the Min Amplitude field shows only detections of amplitude higher than or equal to 
that value. For example, if the minimum amplitude is set to 5.0, only the detections of amplitude 5.0 and 
higher will be displayed. 

The value entered in the Max Amplitude field will show only detections of amplitude lower than or equal to 
that value. For example, if the maximum amplitude is set to 8.0, only the detections of amplitude 8.0 and 
lower will be displayed. 

Setting a value in both fields will result in a range of amplitude to display. 
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Min and Max Distance 

The value entered in the Min Distance field will show only detections at a distance greater than or equal to 
that value. For example, if the minimum distance is set to 10.0, only the detections at a distance of 10.0 and 
more will be displayed. 

The value entered in the Max Distance field will show only detections at a distance smaller than or equal to 
that value. For example, if the minimum distance is set to 20.0, only the detections at a distance of 20.0 and 
less will be displayed. 

Setting a value in both fields will result in a range of distance to display. 

Check boxes 1 to 8 

Check boxes 1 to 8 allow you to select which segments to display. 

Freeze 

When selected, the Freeze option allows you to freeze the values displayed in the Raw Detections dialog 
box. To return to the live display, clear the check box. 

Seg 

The Seg column lists the segment for which there is a detection according to the filters used. The segment 
numbers are read from left to right, starting at 8. 

Distance and Amplitude 

The Distance column displays the distance of the detection, and the Amplitude column displays its 
amplitude. 

Flags 

The Flags column displays a number that represents a detection type. See Table 8 in section 4.2. 

6.13. Reset 

The Reset option allows you to reset the module its default settings. 

In the Device menu, select Action, then click Reset to factory default configuration.... 

 

Fig. 70: Device menu – Reset 

You will be prompted for confirmation, as the Reset action cannot be undone. 
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6.14. Serial Port Viewer 

The Serial Port Viewer function allows you to monitor serial port communication data (View menu > Serial 

Port Viewer). 

 

Fig. 71: Serial Port Viewer 

6.15. Help 

6.15.1. User Guide 

In the Help menu, select User Guide…. 

 

Fig. 72: Help menu – Accessing the User Guide 

This option allows you to access a PDF version of the Leddar Vu8 User Guide directly from Leddar 
Configurator. 

6.15.2. About 

 

Fig. 73: Help menu – Accessing the About window 

In the Help menu, select About…. 

This option allows you to know which dynamic link libraries are currently used in the Vu8 module and the 
software part number. This information is useful when contacting LeddarTech support. 
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7. Specifications 

7.1. General 

Table 72: General specifications 

Description Value 

Light source pulse rate 51.2 kHz 

Photodetector array size 1 x 8 

Photodetector acquisition rate 100 MHz 

Measurement rate See Table 12 on page 39. 

USB (optional) 2.0, 12 Mbits/s 

CAN (optional) 10 to 1 000 kbits/s, optional 120-Ω termination 

Serial links (optional) 
TTL, RS-232, RS-422 and RS-485. Two-wire, four-wire, 9 600 to 
115 200 bps 

Operating temperature −40 °C to +85 °C 

7.2. Regulatory Compliance 

The Leddar Vu8 module complies with FDA performance standards for laser products except for deviations 
pursuant to Laser Notice No. 50 dated June 24, 2007. 

 
Testing results are valid for a cable length shorter than 3 meters. 

Table 73: Regulatory compliance information 

Standard Test Specification Certification Result 

Radiated Emissions 

FCC Part 15 (2013), Subpart B 

Class A 

30 MHz – 1 GHz 
N/A Pass 

Radiated Emissions 

CISPR11 (2009) A1 (2010) 

Group 1 – Class A 

30 MHz – 1 GHz 
N/A Pass 

Radiated Emissions 

ICES-003 (2012) 

Class A 

30 MHz – 1 GHz 
N/A Pass 

Electrostatic Discharge Immunity 

IEC61000-4-2 (2008) 

Contact: ±4 kV 

Air: ±8 kV 
Class C Pass 

Radiated Electromagnetic Field Immunity 

IEC61000-4-3 (2006) 

A1 (2007) A2 (2010) 

80 MHz – 1 000 MHz: 10 V/m 

1.4 GHz – 2 GHz: 3 V/m 

2 GHz – 2.7 GHz: 1 V/m 

Class C Pass 
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7.3. Electrical 

Table 74: Electrical specifications 

Description Value 

Voltage 12 VDC ±0.6 V 

Power consumption (total) <2.2 W 

Power output maximum current 15 mA 

7.4. Optical 

Table 75: Optical specifications 

Description Value 

Wavelength 905 nm (infrared) 

Laser risk group IEC 60825-1:2014 (Third Edition); Class I laser product 

Beam width and height (HFoV and VFoV) See Table 76 below. 

Table 76: HFoV and VFoV 

Horizontal FoV2 Vertical FoV2 

16° ± 1° 0.3° ± 0.2° 

16° ± 1° 2° ± 0.6° 

48° ± 3.5° 0.3° ± 0.15° 

48° ± 3.5° 3° ± 0.6° 

99° ± 5° 0.3° ± 0.15° 

99° ± 5° 3° ± 0.25° 

 

2 Sensitivity of the module across the horizontal FoV (segment amplitude efficiency) and vertical FoV (amplitude vs. 
tilt). See Fig. 74. 
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Fig. 74: Horizontal field of view (HFoV) and vertical field of view (VFoV) 

7.5. Performance 

Table 77: Module performances 

Performance Metric Value 

Measurement accuracy3 ±5 cm 

Measurement precision 6 mm (amplitude >15) 

Resolution 1 cm 

Range (maximum light source intensity) 
Varies with beam optics and target properties (see 
amplitude vs. range figures below). 

Data refresh rate Up to 100 Hz (standard board) 

 

3 For oversampling of 4 and more. 
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Fig. 75: 16° x 0.3° 
(Maximum intensity, accumulation = 256, oversampling = 8) 

 

Fig. 76: 16° x 2° 
(Maximum intensity, accumulation = 256, oversampling = 8) 



 

54A0028_V8.0_EN / Leddar Vu8 – User Guide 99 | 110 

 

Fig. 77: 48° x 0.3° 
(Maximum intensity, accumulation = 256, oversampling = 8) 

 

Fig. 78: 48° x 3° 
(Maximum intensity, accumulation = 256, oversampling = 8) 
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Fig. 79: 99°x 0.3° 
(Maximum intensity, accumulation = 256, oversampling = 8) 

 

Fig. 80: 99° x 3° 
(Maximum intensity, accumulation = 256, oversampling = 8) 
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7.6. Dimensions 

7.6.1. 99° Module 

 

Fig. 81: 99° module dimensions 

7.6.2. 48° Module 

 

Fig. 82: 48° module dimensions 
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7.6.3. 16° Module 

 

Fig. 83: 16° module dimensions 
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8. Troubleshooting 

Contact LeddarTech for troubleshooting information concerning the Leddar Vu8 module. 

9. Maintenance 

Manipulation 
Avoid touching the optical surfaces as fingerprints can permanently damage 
the optical coatings. 

Cleaning the 
optical surfaces 

• Blow off dust using compressed air. 

• Clean the optical surfaces with premium-grade optical tissues only. 

Do not use cotton-tipped applicators. If needed, clean the optical surfaces 
with isopropyl alcohol instead. 

For any questions or concerns on how to safely perform maintenance operations on the Leddar Vu8 module, 
contact LeddarTech support at support@leddartech.com. 

10. Disposal 

Like any electronic equipment, the Leddar Vu8 module contains environmentally unsustainable components. 
Dispose of in an environmentally responsible manner. 

11. Technical Support 

For technical enquiries, contact LeddarTech technical support at support@leddartech.com to easily: 

• follow up on your requests 

• find quick answers to questions 

• get valuable updates 

Also, see the contact information at the end of this document. 

Please have all relevant information such as part numbers, serial numbers and pictures to facilitate support. 

  

mailto:support@leddartech.com
mailto:support@leddartech.com
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Appendix A. Example of a 0x04 Function (Read Input 
Register) 

Transmitted message 

01 04 00 01 00 27 E1 D0 

Use the 0x04 command to read 39 consecutive registers starting at address 01. On device with Modbus 
address 01, using the CRC D0 E1. 

Received message 

01 04 4E 00 01 00 08 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 08 00 64 00 00 B0 F7 00 00 00 
0F 00 0E 00 0C 00 0D 00 0E 00 12 00 16 00 19 5A E3 5B F5 5E 26 62 29 63 92 75 13 7C 2B 5B 66 00 01 
00 01 00 01 00 01 00 01 00 09 00 09 00 01 66 6F 

1, 8, 0, 0, 0, 0, 0, 0, 0, 0, 8, 100, 0, 45303, 0, 15, 14, 12, 13, 14, 18, 22, 25, 23267, 23541, 24102, 25129, 
25490, 29971, 31787, 23398, 1, 1, 1, 1, 1, 9, 9, 1 

Header: 1, 8, 0, 0, 0, 0, 0, 0, 0, 0, 8, 100, 0, 45303, 0 

(Address 1) Status for Polling mode: 1 = Detections ready 

(2) Number of segments: 8 = 8 segments 

(11) Number of detection: 8 = 8 detections 

(12) Light source power: 100 = 100% 

(14&15) Timestamp: 45303 = 45303 ms 

Distance (first detection only): 15, 14, 12, 13, 14, 18, 22, 25 

(Address 16) Segment #8 = 15 cm 

(17) Segment #7 = 14 cm 

(18) Segment #6 = 12 cm 

(19) Segment #5 = 13 cm 

(20) Segment #4 = 14 cm 

(21) Segment #3 = 18 cm 

(22) Segment #2 = 22 cm 

(23) Segment #1 = 25 cm 

Amplitude (first detection only): 23267, 23541, 24102, 25129, 25490, 29971, 31787, 23398 

(Address 24) Segment #8 = 23267 / 64 = 363.55 counts 

(25) Segment #7 = 23541 / 64 = 367.83 counts 

(26) Segment #6 = 24102 / 64 = 376.59 counts 

(27) Segment #5 = 25129 / 64 = 392.64 counts 

(28) Segment #4 = 25490 / 64 = 398.28 counts 

(29) Segment #3 = 29971 / 64 = 468.30 counts 

(30) Segment #2 = 31787 / 64 = 496.67 counts 

(31) Segment #1 = 23398 / 64 = 365.59 counts 
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Flag (first detection only): 1, 1, 1, 1, 1, 9, 9, 1 

(Address 32) Segment #8 = 1 = Valid 

(33) Segment #7 = 1 = Valid 

(34) Segment #6 = 1 = Valid 

(35) Segment #5 = 1 = Valid 

(36) Segment #4 = 1 = Valid 

(37) Segment #3 = 9 = Saturation 

(38) Segment #2 = 9 = Saturation 

(39) Segment #1 = 1 = Valid 
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Appendix B. Example of a 0x41 Modbus Function 

Transmitted data stream message 

01 41 C0 10 

Use the 0x41 command to read on device Modbus address # 01, using the CRC 10 C0. 

Received data stream message 

01 41 08 25 00 52 81 09 07 25 00 49 81 09 06 24 00 4F 81 09 05 25 00 05 81 09 04 29 00 A9 7D 09 03 2E 
00 96 66 01 02 35 00 CC 47 01 01 39 00 64 33 01 00 F0 4C 1A 00 64 00 00 D2 EE 

Get detection messages (first byte) 

Modbus address: 01 hex = 1 = Address#1 

Function code: 0x41 hex = 65 = function 0x41 

Number of detections: 08 hex = 8 = 8 detections 

Get detection messages (detection fields) 

(1) 25 00 52 81 09 07: 
Distance (cm): 00 25 hex = 37 cm = 0.37 m 

Amplitude (count): 81 52 hex = 33106 / 64 = 517.28 counts 

Flag: 09 hex = 9 (Saturation) 

Segment #: 07 hex = 7 (Segment #8) 

(2) 25 00 49 81 09 06: 
Distance (cm): 00 25 hex = 37 cm = 0.37 m 

Amplitude (count): 81 49 hex = 33097 / 64 = 517.14 counts 

Flag: 09 hex = 9 (Saturation) 

Segment #: 06 hex = 6 (Segment #7) 

(3) 24 00 4F 81 09 05: 
Distance (cm): 00 24 hex = 36 cm = 0.36 m 

Amplitude (count): 81 4F hex = 33103 / 64 = 517.23 counts 

Flag: 09 hex = 9 (Saturation) 

Segment #: 05 hex = 5 (Segment #6) 

(4) 25 00 05 81 09 04: 
Distance (cm): 00 25 hex = 37 cm = 0.37 m 

Amplitude (count): 81 05 hex = 33029 / 64 = 516.08 counts 

Flag: 09 hex = 9 (Saturation) 

Segment #: 04 hex = 4 (Segment #5) 

(5) 29 00 A9 7D 09 03: 
Distance (cm): 00 29 hex = 41 cm = 0.41 m 

Amplitude (count): 7D A9 hex = 32169 / 64 = 502.64 counts 
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Flag: 09 hex = 9 (Saturation) 

Segment #: 03 hex = 3 (Segment #4) 

(6) 2E 00 96 66 01 02: 
Distance (cm): 00 2E hex = 46 cm = 0.46 m 

Amplitude (count): 66 96 hex = 26262 / 64 = 410.34 counts 

Flag: 01 hex = 1 (Valid) 

Segment #: 02 hex = 2 (Segment #3) 

(7) 35 00 CC 47 01 01: 
Distance (cm): 00 35 hex = 53 cm = 0.53 m 

Amplitude (count): 47 CC hex = 18380 / 64 = 287.19 counts 

Flag: 01 hex = 1 (Valid) 

Segment #: 01 hex = 1 (Segment #2) 

(8) 39 00 64 33 01 00: 
Distance (cm): 00 39 hex = 57 cm = 0.57 m 

Amplitude (count): 33 64 hex = 13156/ 64 = 205.56 counts 

Flag: 01 hex = 1 (Valid) 

Segment #: 00 hex = 0 (Segment #1) 

Get detection messages (trailing fields) 

(1) F0 4C 1A 00 64 00 00: 
TimeStamp (ms): 00 1A 4C F0 hex = 1 723 632 ms = 1723 s 

Light source POWER (%): 64 hex = 100 = 100% 

Bit field acq. (reserved): 00 00 hex = 0 

CRC (16bits Modbus) = EE D2 
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Appendix C. Example of a Leddar Vu8 CAN Bus 
Detection Request 

A request is sent to the sensor; this request is an 8-byte message that is addressed to the message ID 
0x740. The sensor then replies with multiple 8-byte messages addressed to the message ID 0x750 +. 

There are two possible modes: 

1. For example, to obtain a detection frame (polling), in the multiple message mode, send this request: 
0x740: 02, 01, 00, 00, 00, 00, 00, 00 

The sensor will then answer with the following sequence: 

0x750: 02 01 00 00 00 00 00 00: echo of the successful request 

0x751: 08 64 00 00 41 8D 26 00: number of detections (8), LED power (100%), timestamp (2526529 
msec) 

0x752: 77 05 8F 00 01 00 07 00: detection of channel #7, distance (0x0577 = 1399 cm), amplitude 
(0x008F = 143/64 = 2.2344 counts), flag info (0x0001 = valid) 

0x753: 0E 05 D3 00 01 00 06 00: detection of channel #6 

0x754: 05 05 EC 00 01 00 05 00: detection of channel #5 

0x755: 03 05 F9 00 01 00 04 00: detection of channel #4 

0x756: 0D 05 F2 00 01 00 03 00: detection of channel #3 

0x757: 1B 05 ED 00 01 00 02 00: detection of channel #2 

0x758: 2D 05 B9 00 01 00 01 00: detection of channel #1 

0x759: 97 05 9F 00 01 00 00 00: detection of channel #0 

2. For the sensor to send data streaming in the simple message mode, initiate the communication with 
the request: 

0x740: 03, 00, 00, 00, 00, 00, 00, 00 

The sensor will then answer with the following sequence: 

0x750: 03 00 00 00 00 00 00 00: echo of the successful request 

0x751: 08 64 00 00 41 8D 26 00: detection frame N: number of detections (8), LED power (100%), 
timestamp (2526529 msec) 

0x752: 77 05 8F 00 01 00 07 00: detection of channel #7, distance (0x0577 = 1399 cm), amplitude 
(0x008F = 143/64 = 2.2344 counts), flag info (0x0001 = valid) 

0x752: 0E 05 D3 00 01 00 06 00: detection of channel #6 

0x752: 05 05 EC 00 01 00 05 00: detection of channel #5 

0x752: 03 05 F9 00 01 00 04 00: detection of channel #4 

0x752: 0D 05 F2 00 01 00 03 00: detection of channel #3 

0x752: 1B 05 ED 00 01 00 02 00: detection of channel #2 

0x752: 2D 05 B9 00 01 00 01 00: detection of channel #1 

0x752: 97 05 9F 00 01 00 00 00: detection of channel #0 

0x751: 08 64 00 00 41 8D 26 00: detection frame N+1 

0x752: 77 05 8F 00 01 00 07 00 
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0x752: 0E 05 D3 00 01 00 06 00 

0x752: 05 05 EC 00 01 00 05 00 

0x752: 03 05 F9 00 01 00 04 00 

0x752: 0D 05 F2 00 01 00 03 00 

0x752: 1B 05 ED 00 01 00 02 00 

0x752: 2D 05 B9 00 01 00 01 00 

0x752: 97 05 9F 00 01 00 00 00 

0x751: 08 64 00 00 41 8D 26 00: detection frame N+2 

0x752: 77 05 8F 00 01 00 07 00 

0x752: 0E 05 D3 00 01 00 06 00 

0x752: 05 05 EC 00 01 00 05 00 

0x752: 03 05 F9 00 01 00 04 00 

0x752: 0D 05 F2 00 01 00 03 00 

0x752: 1B 05 ED 00 01 00 02 00 

0x752: 2D 05 B9 00 01 00 01 00 

0x752: 97 05 9F 00 01 00 00 00 

To stop the data streaming, send the request: 

0x740: 01, 00, 00, 00, 00, 00, 00, 00 

The sensor the responds with the following message: 

0x750: 01 00 00 00 00 00 00 00: echo of the successful request 
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